
 

 

 

 

EDR Technical Reference Guide 

Indian Health Service (IHS) 
Electronic Dental Record (EDR) 

Version 4.0 
6/21/2023 



ii Contents 

 
 

IHS EDR Technical Reference Guide 

 

Contents 
A. IHS Business Continuity/Server Backup Plan for EDR (Dentrix 

Enterprise).............................................................................................. 1 

1. Overview ................................................................................................................... 1 

2. Hardware & General Data Backup Recommendations .......................................... 2 

2.1 Hardware .............................................................................................................................. 2 

2.2 Redundant Hardware ............................................................................................................ 2 

2.3 Operating System ................................................................................................................. 3 

2.4 Business Critical Applications ................................................................................................ 3 

EDR Backup ................................................................................................................... 4 

2.5 Critical EDR Data, Directories, and Files ................................................................................ 4 

2.6 Sample Maintenance Plans................................................................................................... 5 

2.7 Critical Operating System Data Folders and Files ................................................................. 19 

2.8 Data Backup Schedule ........................................................................................................ 19 

3. Rebuilding EDR and Image Database Server and Hardware Recovery 

Recommendations and Processes ........................................................................ 20 

3.1 Hardware ............................................................................................................................ 20 

3.2 Operating System ............................................................................................................... 20 

3.3 Business Critical Applications .............................................................................................. 20 

3.4 Overview of Steps ............................................................................................................... 20 

4. Standard EDR Database Maintenance Plan ......................................................... 21 

4.1 Recommendations .............................................................................................................. 21 

4.2 Certified Database Administrator Recommended ................................................................. 21 

4.3 MS SQL Server Documentation .......................................................................................... 22 

5. Detailed EDR Database Backup and Maintenance ............................................... 22 

6. Install SQL Server Instance.................................................................................... 24 

Appendix A: Support Contact Information .................................................................. 26 

B. MiPACS Dental Enterprise (Medicor Imaging) ...................................... 27 

1. System Specifications for MiPACS Dental Enterprise PACS Components ......... 27 

1.1 Server Requirements/Recommendations ............................................................................ 27 

1.2 Desktop Client Requirements/Recommendations ................................................................ 30 



 

Contents iii 

 

IHS EDR Technical Reference Guide 
 

1.3 HTML5 Web Viewer Client Requirements/Recommendations ............................................. 31 

1.4 TCP/IP Port Communication Diagram ................................................................................. 32 

1.5 Network Specifications ........................................................................................................ 33 

1.6 Data Backup Information..................................................................................................... 33 

1.7 Antivirus Exclusions: Files/Folders To Exclude .................................................................... 33 

1.8 Support Contact Information ............................................................................................... 33 

2. MiPACS Dental Enterprise Viewer 4.0 Installation Instructions ........................... 34 

2.1 Labelling and Symbols ........................................................................................................ 34 

2.2 Introduction ......................................................................................................................... 34 

2.3 System Requirements ......................................................................................................... 35 

2.4 Supported Equipment ......................................................................................................... 36 

2.5 Installation .......................................................................................................................... 38 

2.6 Database Setup .................................................................................................................. 40 

2.7 Application Setup ................................................................................................................ 44 

2.8 License Management.......................................................................................................... 47 

2.9 Plugin Setup ....................................................................................................................... 47 

2.10 X-ray Imaging System Calibration ............................................................................... 51 

2.11 Patient Management System Integration ..................................................................... 55 

2.12 Templates ................................................................................................................... 55 

2.13 Upgrading from a Previous MiPACS Version ............................................................... 56 

2.14 Problem Solving/Troubleshooting ................................................................................ 57 

3. MiPACS Business Continuity ................................................................................. 59 

3.1 EDR MIPACS Business Continuity Software Setup ............................................................. 59 

3.2 EDR MIPACS Business Continuity User Setup ................................................................... 61 

Appendix B: Component-Specific Instructions ........................................................... 63 

B1. Autoimport .......................................................................................................................... 63 

B2. Belmont BelSensor GOLD .................................................................................................. 64 

B3. Camera WIA ....................................................................................................................... 65 

B4. Carestream ......................................................................................................................... 66 

B5. C-Takt Link ......................................................................................................................... 67 

B6. Dentalmind Digital X-ray II................................................................................................... 68 

B7. Dürr VistaEasy .................................................................................................................... 69 

B8. Export ................................................................................................................................. 70 



iv Contents 

 
 

IHS EDR Technical Reference Guide 

 

B9. ImageLevel NV SA MDX3 ................................................................................................... 72 

B10. Instrumentarium ................................................................................................................ 73 

B11. Kavo Gendex .................................................................................................................... 74 

B12. Manual Import ................................................................................................................... 75 

B13. Medspace ......................................................................................................................... 76 

B14. Morita ............................................................................................................................... 77 

B15. Planmeca.......................................................................................................................... 78 

B16. Schick Intraoral ................................................................................................................. 79 

B17. Sirona ............................................................................................................................... 80 

B18. Soredex ............................................................................................................................ 81 

B19. TWAIN .............................................................................................................................. 82 

B20. Video ................................................................................................................................ 83 

B21. Canon EOS Direct Capture ............................................................................................... 85 

B22. SQL Backup Script ............................................................................................................ 87 

B23. Patient Selector ................................................................................................................ 88 

B24. Command Line Link .......................................................................................................... 91 

Appendix C: Installation Approval Form...................................................................... 94 

C. Digital Image Application (DEXIS) ........................................................ 95 

1. Overview of Application .......................................................................................... 95 

2. System Requirements ............................................................................................ 95 

3. Basic Network Setup .............................................................................................. 95 

4. Installation Steps .................................................................................................... 95 

5. Data Backup Information ........................................................................................ 95 

6. Antivirus Exclusions ................................................................................................ 96 

7. Support ................................................................................................................... 96 

 



 

Dentrix Enterprise 1 

 

IHS EDR Technical Reference Guide 
 

A. IHS Business Continuity/Server Backup 
Plan for EDR (Dentrix Enterprise) 

1. Overview 
The recommendations in this document are guidelines for providing business continuity/disaster recovery 
for the Electronic Dental Record (EDR) project to be able to provide dental care to your patients and 
customers should hardware or software failures occur. All policies and procedures for reporting, 

recovering, and supporting your business’s critical hardware, software, and data should be in accordance 
with national IHS policies and your local sites policies and procedures to recover systems as efficiently as 
possible. The guidelines below are for general recovery of hardware and/or software failures. Disasters 
resulting from natural or environmental events will need to be addressed through your local sites business 

continuity plan. 

The data in your dental database is one of your most valuable resources used in running your dental 
business. You are responsible for maintaining their database and for ensuring that you have an adequate 
disaster recovery plan. To accomplish this, you will need trained personnel and the equipment necessary 
to support your database and to be able to implement your disaster recovery plan (see Appendix A: 
Support Contact Information). In order to protect your investment, a backup and disaster recovery plan 

must be developed, implemented, maintained, and tested to protect the data. Processes must be in place to 
repair hardware as well as recover data and restore/reinstall the associated software needed to run the 

servers to get systems back on line. 

The purpose of this document is to provide general guidelines for a business continuity plan for the EDR 
in the event of various hardware, software, or disaster events that may disrupt normal business operations. 
This document will provide overviews, recommendations, and some specific details that can be used to 

create a disaster recovery plan for the EDR or to merge the EDR into an existing disaster recovery plan. 

However, this document is not intended to provide, nor can it provide, all necessary information, 

steps, training, and configurations to fully develop and implement a disaster recovery plan. This 
document assumes that local IT staff and management will have some existing training and experience 
with installing, configuring, and supporting IT tools, operating systems, domains, database servers, 
backup tools, disaster recovery plans, and so forth to implement an effective disaster recovery plan fully 

and successfully for the EDR. 
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2. Hardware & General Data Backup 
Recommendations 

2.1 Hardware 

In order to avoid certain system outages, it is recommended to have redundant or backup hardware 
whenever possible. It is also recommended that you get hardware maintenance support through the 
hardware vendor with a 4-hour response time or better. This will assist in the elimination or reduction of 
extended system outages due to hardware failures and allow you to leverage the existing technology 

solutions to best serve your patients and customers. 

2.2 Redundant Hardware 

It is recommended that your hardware solution offer redundancy whenever possible. This includes, but is 

not limited to, redundant power supplies, various forms of RAID configurations, and extra servers. 

Remote Vendor Support 

Your hardware vendor/manufacturer should have a warranty provided by the manufacturer to assist in 
resolution of your business-critical hardware. This should include 24x7 responses from a certified 
hardware and software technician to troubleshoot your issues and then offer recommended and supported 
solutions. It is recommended that appropriate personnel be aware of and know how to contact and obtain 

warranty hardware support from their service contract should the need arise. 

Onsite Vendor Support 

Your hardware vendor/manufacturer should dispatch a technician with replacement components to get 
you up and running within the committed service levels of the manufacturer warranty. Manufacturer 

warranties (including how to contact the vendor) will be delivered with the server hardware at the time of 

installation. 
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2.3 Operating System 

Discs and Licenses 

Original installation CDs and/or DVDs and licenses for the operating system and other purchased 
products will be delivered with the EDR server hardware. These discs and licenses should be stored in a 

safe place for use in a disaster recovery situation in order to reinstall the operating system and associated 

products. 

OS Files and Data 

All critical operating system directories and data files should be backed up to storage media and/or 
external disk on a nightly basis and should be stored offsite for security purposes. This will ensure the 
data is available for recovery should a disaster happen with the facility and all systems are lost. These 
backups will also allow for recovery of corrupt or missing files and/or directories in the case of a minor 
failure. These could be critical system files, application files, client files, document folders, and so forth. 
The processes associated with this backup methodology should be in accordance with local business 

continuity policies. 

2.4 Business Critical Applications 

Application Data 

All business critical application data including non‐EDR related applications should be backed up to 
storage media and/or an external disk (detachable drives) and be stored offsite for security purposes. This 
will ensure that the data is available for recovery should a disaster happen at the facility that results in a 
total loss of all systems. The storage media will also allow for recovery of corrupt or missing files and/or 
directories. These could be critical system files, application files, client files, documents, and so forth. 

Access to the storage media will allow for quick recovery of the business applications. The processes 
associated with this backup methodology should be in accordance with local business continuity policies. 
The restore process should be tested periodically to validate the reliability of the backup solution prior to 

an emergency occurring. 
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EDR Backup 

2.5 Critical EDR Data, Directories, and Files 

EDR Data 

The data stored in the EDR database is crucial to providing patient care and running the dental business. 

Ensuring that a proper EDR data backup plan for each EDR location is in place and working is critical. 

Initial Backup Configuration 

When the database server is delivered for the EDR project, it will come preconfigured with backup plans 
for both the MS SQL Server and external backups. Training will be provided during the hardware 

installation to show the local IT personnel how to check these pre‐configured plans. IT personnel can use 

pre‐configured backup plans as is, or they can modify and/or add items to meet the specific requirements 

for the site. 

EDR Server Initial Configuration 

When EDR servers are delivered to and installed at the sites, a completed hardware configuration form for 
that specific server will be supplied to the IT personnel. The IT personnel will want to save this form in a 
safe location. The hardware configuration form will provide all the details of how the server hardware is 

configured, such as memory, processor, hard drives, raid configuration, and OS versions. 

Backup Prerequisites 

It is very important to run SQL maintenance plans prior to running your nightly data backups. For those 
locations that are also storing digital images, you will need to run a maintenance plan for that database as 

well. 
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2.6 Sample Maintenance Plans 

The following sample, pre-configured MS SQL maintenance plans are for the EDR and Image databases. 

EDR Database (SQL) Maintenance Plans 

1. In SSMS, connect to the Dentrix_Live instance. 

 

2. On the Object Explorer pane, expand Management.  Right-click Maintenance Plans, and then 

click Maintenance Plan Wizard. 

 

The Maintenance Plan Wizard starts. 
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3. Click Next. 

The Select Plan Properties page appears. 

 

4. In the Name box, enter DENTRIX_LIVE DB Backup. 

5. Next to Schedule, click Change. 

The New Job Schedule dialog box appears. 
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6. Under Frequency, select the Monday, Tuesday, Wednesday, Thursday, and Friday 

checkboxes. 

7. Under Daily frequency, with the Occurs once at option selected, enter 8:00:00 PM in the 

corresponding box. 

8. Click OK. 

 

9. Click Next. 

The Select Maintenance Tasks page appears. 
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10. In the list, select the checkbox for Back Up Database (Full) and the checkbox for Maintenance 

Cleanup Task. 

11. Click Next. 

The Select Maintenance Task Order page appears. 

 

12. Click Next. 

The Define Back Up Database (Full) Task page appears. 



 

Dentrix Enterprise 9 

 

IHS EDR Technical Reference Guide 
 

13. On the General tab, expand the Database(s) list, with the These databases option selected, 

select the checkboxes for Dentrix and master, and then click OK. 

 

14. On the Destination tab, with the Create a backup file for every database option selected, click 

the Browse button (...) next to Folder, and then select the correct backup directory: 

D:\SQLBACKUPS\DENTRIX_LIVE. 
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15. In the Backup file extension box, enter bak. 

Important: Do not include a dot before the file extension (enter “bak” not “.bak”). 

16. Click Next. 

The Define Maintenance Cleanup Task page appears. 

 

17. With the Search folder and delete files based on an extension option selected, click the Browse 
button (...) next to Folder, and then select the correct backup directory: 

D:\SQLBACKUPS\DENTRIX_LIVE. 

18. In the File extension box, enter bak. 

Important: Do not include a dot before the file extension (enter “bak” not “.bak”). 

19. Under File age, select the Delete files based on the age of the file at task run time checkbox. 
Then, for Delete files older than the following, enter 1 in the box, and select Week(s) from the 

list. 

20. Click Next. 

The Select Report Options page appears. 
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21. Click Next. 

The Complete the Wizard page appears. 

 

22. Click Finish. 

The Maintenance Plan Wizard Progress page appears. 
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23. After the operations finish, click Close. 

You are returned to SSMS. 

24. On the Object Explorer pane, right-click Maintenance Plans, and then click Maintenance Plan 

Wizard. 

 

The Maintenance Plan Wizard starts. 
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25. Click Next. 

The Select Plan Properties page appears. 

 

26. In the Name box, enter DENTRIX_LIVE LOG Backup. 

27. Next to Schedule, click Change. 

The New Job Schedule dialog box appears. 
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28. Under Frequency, select the Monday, Tuesday, Wednesday, Thursday, and Friday 

checkboxes. 

29. Under Daily frequency, select the Occurs every option. Then, enter 6:00:00 AM in the Starting 

at box, and 7:30:00 PM in the Ending at box. 

30. Click OK. 

 

31. Click Next. 

The Select Maintenance Tasks page appears. 
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32. In the list, select the checkbox for Back Up Database (Transaction Log) and the checkbox for 

Maintenance Cleanup Task. 

33. Click Next. 

The Select Maintenance Task Order page appears. 

 

34. Click Next. 
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35. On the General tab, expand the Database(s) list, with the These databases option selected, 

select the checkbox for Dentrix, and then click OK. 

 

36. On the Destination tab, with the Create a backup file for every database option selected, click 
the Browse button (...) next to Folder, and then select the correct backup directory: 

D:\SQLBACKUPS\DENTRIX_LIVE. 

 

37. In the Backup file extension box, enter trn. 
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Important: Do not include a dot before the file extension (enter “trn” not “.trn”). 

38. Click Next. 

The Define Maintenance Cleanup Task page appears. 

 

39. With the Search folder and delete files based on an extension option selected, click the Browse 
button (...) next to Folder, and then select the correct backup directory: 

D:\SQLBACKUPS\DENTRIX_LIVE. 

40. In the File extension box, enter trn. 

Important: Do not include a dot before the file extension (enter “trn” not “.trn”). 

41. Under File age, select the Delete files based on the age of the file at task run time checkbox. 
Then, for Delete files older than the following, enter 4 in the box, and select Day(s) from the 

list. 

42. Click Next. 

The Select Report Options page appears. 
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43. Click Next. 

The Complete the Wizard page appears. 

 

44. Click Finish. 

The Maintenance Plan Wizard Progress page appears. 
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45. After the operations finish, click Close. 

Image Database Maintenance Plans 

For either the DEXIS Imaging Suite database or the MiPACS database, follow the same process as 

explained for the Dentrix Enterprise database. 

2.7 Critical Operating System Data Folders and Files 

The following are the folders that should be backed up to either a NAS or external media on a nightly 

basis: 

• Doc_Center – Folder containing all documents scanned into the Dentrix Enterprise Document 
Center. 

• DXONE – Shared writeable folder containing customizations and report templates. 

• Dexis Imaging Suite or TXTOUT, Image store for MiPACS – Folder containing digital images 
for the clinic. 

• ORIGINAL – Folder containing all software and settings needed to reinstall the implementation. 

• SQLBACKUPS – Folder containing database backups for Dentrix and DEXIS/MiPACS. 

Local IT personnel should review their local drives, directories, and files to determine what other data 

should be backed up and add it to the backup process. 

2.8 Data Backup Schedule 

It is recommended that critical system and application files be backed up on a nightly basis. Typical 
schedules will be set to run Monday through Friday after business hours. If the facility is open for 
business on Saturday or Sunday, a Saturday/Sunday night backup is recommended as well. Every 
morning the backup logs should be reviewed to confirm a successful backup was completed. If so, the 
removable media should be disconnected and replaced with the next device. Disconnected backup media 

should be stored in a fire-safe location onsite or stored at a secure offsite location. 
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3. Rebuilding EDR and Image Database Server and 
Hardware Recovery Recommendations and 
Processes 

3.1 Hardware 

Restoration of physical hardware configurations should follow your local center’s support policy 
combined with the warranty provided by the hardware vendor. Once you have completed the replacement 

of failed hardware components, proceed to section 4.2 Operating System. 

3.2 Operating System 

When reinstalling the base operating system (Windows Server), you should follow your local center’s 

support policy. This will include the following: 

• The loading of the Windows Server operating system. 

• The installation of system service packs, drivers, patches, and so forth. 

• The configuration of the system (computer name, IP address, network settings, and so forth). 

Once the operating system is reinstalled and configured, proceed to section 4.3 Business Critical 

Applications. 

3.3 Business Critical Applications 

Restoration of the business applications will follow your local center’s support policy in combination with 

the following recommendations for the Dentrix Enterprise and imaging software. 

3.4 Overview of Steps 

Required software: 

• A copy of the Microsoft Server operating system software (which was delivered with the server) 
and the necessary service packs. 

• A copy of the Microsoft SQL Server database software (which was loaded in the Original folder 
on the Data partition) and the necessary service packs. 

• A copy of the Dentrix Enterprise software (which was delivered with the server). 

• A copy of the Image software (which was delivered with the server). 

Installation: 

1. Install the Windows Server OS, and configure the hardware. 

2. Install Microsoft SQL Server on the database server. 

• Use the SQL Server version appropriate for the version of Dentrix Enterprise in use. Go 

to https://www.dentrixenterprise.com/support/requirements to verify the correct version. 

https://www.dentrixenterprise.com/support/requirements
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• Install an instance of SQL Server for Dentrix Enterprise (see section 7. Install SQL Server 
Instance). 

3. Restore the SQL maintenance plans (see section 3.2 Sample Maintenance Plans): 

• Restore the Dentrix Enterprise maintenance plan from the backup media to a TEMP 
directory. 

• Restore the Image maintenance plan from the backup media to a TEMP directory. 

• Restore the files from the TEMP directory to the SQL instance. 

4. Contact Dentrix Enterprise Support (800) 459‐8067 for assistance running scripts to restore the 

database. 

5. If the images are on the same server as the database, the images folder must be restored from the 

backup media as well. 

6. Install the Dentrix Enterprise software. 

7. Install the Image software. 

4. Standard EDR Database Maintenance Plan 

4.1 Recommendations 

The data in your EDR dental database is one of your most valuable resources that are used in running your 
dental business. You are responsible for maintaining their database and for ensuring that you have an 
adequate disaster recovery plan. To accomplish this, you will need trained personnel and the equipment 
necessary to support your database and to be able to implement your disaster recovery plan. In order to 
protect your investment, a disaster recovery plan needs to be developed, implemented, maintained, and 

tested. 

This section provides general maintenance items that you should review with your database administrator 

(DBA) to create a plan to protect and secure your database server and data. Your plan may need to be 

customized to fit your needs and your environment. 

4.2 Certified Database Administrator Recommended 

It is recommended that your DBA should be a Microsoft Certified Solutions Associate (MCSA) for SQL 
Database Administration. A trained and qualified MCSA Database Administrator will already know how 
to accomplish the tasks listed in this document. The best tool to implement and track your maintenance 
plan is the MS SQL Server Management Studio, which is available for download from 
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-

server-ver15. 

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver15
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4.3 MS SQL Server Documentation 

The following link is for all versions of MS SQL Server: https://docs.microsoft.com/en-us/sql/sql-
server/?view=sqlallproducts-allversions. A trained DBA will already be familiar with this information, but 

you are encouraged to visit the link to learn what is best for you. 

5. Detailed EDR Database Backup and Maintenance 
Note: Clicking any link presented will take you to the corresponding MS SQL documentation that 

describes the applicable concepts and features and provides detailed instructions for completing the task. 

We recommend using the following items as part of your plan: 

• Have a backup and restore plan for all databases – You need to create a plan to protect your 
data in case of disaster (equipment failure, employee sabotage, fire, and so forth). Determine what 
recovery plan is best for you. See https://docs.microsoft.com/en-us/sql/relational-

databases/maintenance-plans/maintenance-plans?view=sqlallproducts-allversions. 

• Create MS SQL maintenance plans – One of the easiest ways to implement the backup portion 
of this plan is to create a database maintenance plan using the MS SQL Database Maintenance 
Plan Wizard. See https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/use-

the-maintenance-plan-wizard?view=sqlallproducts-allversions. 

• Create a full database backup for key events – A full database backup should be created for key 
events after the initial database setup for any live, test, or training Dentrix databases. These events 

include initial install, go live, upgrading versions, and so forth. 

• Back up and truncate transaction logs – Back up and truncate transaction logs on a daily basis 
to keep them small. 

Important: When SQL Server finishes backing up the transaction log, it automatically truncates 
the inactive portion of the transaction log. This inactive portion contains completed transactions 

and is no longer used during the recovery process. Conversely, the active portion of the 
transaction log contains transactions that are still running and have not yet completed. SQL Server 
reuses this truncated, inactive space in the transaction log instead of allowing the transaction log 
to continue to grow and use more space. Although the transaction log may be truncated manually, 
it is strongly recommended that you do not do this as it breaks the log backup chain. Until a full 
database backup is created, the database is not protected from media failure. Use manual log 
truncation only in very special circumstances, and create a full database backup as soon as it is 

practical. 

• Back up the live EDR database every day – You can use any of the following methods to back 

up: 

• You can use the MS SQL Management Studio and MS SQL Server Agent to backup 

directly to media. 

• You can use the MS SQL Server Agent with your backup program to stop the database, 
do the backup, and then restart the database. 

• You can use the MS SQL Server Management Studio to schedule backups to a flat file. 
This flat file can then be backed up with your backup program. This file can be copied or 

backed up to another machine as well. 

https://docs.microsoft.com/en-us/sql/sql-server/?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/sql-server/?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-plans?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-plans?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-plans?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/use-the-maintenance-plan-wizard?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/use-the-maintenance-plan-wizard?view=sqlallproducts-allversions
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/use-the-maintenance-plan-wizard?view=sqlallproducts-allversions
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Note: Many backup systems cannot effectively or directly backup MS SQL databases. If the MS 
SQL Server engine is running, the files that make up the database are locked, and many backup 
media systems cannot backup the locked database files from outside of the Microsoft SQL Server 
Management Studio. These backup solutions may see that the database files are in use and skip 

those files. 

• Check server drive space – The servers should be checked weekly or monthly to ensure that you 
have adequate available free disk space for the growth of the live database files, transaction logs, 

and backup files. When EDR databases are installed, by default, they are configured to pre‐
allocate an adequate portion of space on your server hard drives to store the database and 

transaction logs. The databases are also configured such that the size of the database and 

transaction log files will grow automatically as needed once the initial pre‐allocated space is filled 
and will continue to grow until the hard drive is full. Use the operating system to check the free 

space on drives. 

• Store database backups offsite – Database backups should be performed weekly or monthly and 
stored offsite in a secure location. In you plan, you may want to incorporate a 3 to 6 month rotation 

of the backups stored offsite. 

• Shrink and defragment databases – The live databases should be shrunk and defragmented 
(moving pages internally to the beginning of the files that make up the database) using the MS 
SQL Server tools monthly or after significant deletions of data in the database (purging 
appointments, purging old audit records, and so forth). Also, the EDR server hard drives 
containing the database should be defragmented on a regular basis at the operating system level 

using the operating system defragmenting tools. This defragmenting of the database files at the 
operating system level will ensure optimal data layout on the drives to enhance database 

performance. 

• Monitor EDR database performance statistics – EDR Database performance statistics should 
be checked monthly or semi‐annually to ensure proper server performance. 

• Rebuild database indexes – Database indexes should be rebuilt semi‐annually or annually to 

ensure optimal index performance. Contact Dentrix Enterprise Support at (800) 459‐8067. This 
will usually be done as you upgrade to new versions of Dentrix Enterprise as they become 

available. 

• Install patches for OS and SQL Server – Check monthly with Microsoft for updates to your 
Windows operating system and MS SQL Server to make sure that you have the latest patches and 
fixes from them. If you are using any other third-party products, you should do the same for 
those. Use the Microsoft Update websites to look for, download, and install patch updates for the 

Windows Server Operating System and MS SQL Server database engine. 

• Evaluate EDR server hardware capacity and performance – The database server hardware 
should be evaluated every 6 months to 1 year or at other significant events (adding significantly 
more users to the database, hosting more locations, and so forth) to check if the hardware is 
handling the needs of the EDR server (processor speed, amount of memory, hard drive speed, 

available space on the hard drive, and so forth). 
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6. Install SQL Server Instance 
To demonstrate the installation of a “DENTRIX_LIVE” instance of SQL Server, SQL Server 2019 
Standard will be used in the following steps. Adjust folder locations to your server configuration, and 

create and document your own SA (System Administrator) password. 

1. In File Explorer, navigate to D:\Original\SQL Server 2019 Standard, and then double-click 

setup.exe. 

The SQL Server Installation Center window appears. 

2. On the left, select Installation, and then click the New SQL Server stand-alone installation or 

add features to an existing installation link. 

The SQL Server 2019 Setup starts, and the Product Key page appears. 

3. Leave the Enter the product key option selected and the product key entered, and then click 

Next. 

The License Terms page appears. 

4. Select the I accept the license terms and Privacy Statement checkbox, and then click Next. 

The Global Rules page appears only if there are rule errors. 

The Microsoft Update page appears only if the Microsoft Update checkbox is not selected in 
Control Panel > All Control Panel Items > Windows Update > Change settings. Selecting 
that check box allows Windows Updates to include the latest updates for all Microsoft products 

when you scan for Windows updates. 

The Product Updates page appears only if SQL Server product updates are available. 

The Install Setup Files page appears. 

5. Setup provides the progress of downloading, extracting, and installing the Setup files. If an 
update for Setup is found and you specify to include it, that update will also be installed. If no 

update is found, Setup will automatically advance. 

The Install Rules page appears. 

6. If no potential problems are detected, click Next.  

The Installation Type page appears only if SQL Server is already installed on the system. 

The Feature Selection page appears. 

7. Select the following features: 

• Database Engine Services. 

• SQL Server Management Studio. 

• SQL Server Configuration Manager. 

• Connectivity Components. 
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8. Change the following installation directories: 

• Instance root directory – Enter D:\DENTRIX_LIVE. 

• Shared feature directory – Enter D:\Program Files\Microsoft SQL Server\. 

• Shared feature directory (x86) – Enter D:\Program Files (x86)\Microsoft SQL 

Server\. 

Note: Each of these paths must be different. 

9. Click Next. 

The Feature Rules page appears only if not all rules pass. 

The Instance Configuration page appears. 

10. Select the Named instance option, and then enter DENTRIX_LIVE in the corresponding box. 

11. In the Instance ID box, enter DENTRIX_LIVE. 

12. Click Next. 

The Server Configuration page appears. 

13. For the SQL Server Agent and SQL Server Database Engine services, leave NT Service as the 

Account Name. 

14. Make sure that the Startup Type for each service is set to Automatic. 

15. Click Next. 

The Database Engine Configuration page appears with the Server Configuration tab selected. 

16. Under Authentication Mode, select the Mixed Mode option, and then enter Ch@ngeM3 in the 

Enter password and Confirm password boxes. 

17. Under SQL Server Administrators, click Add Current User. 

Note: [Server name]\_Administrator (_Administrator) should appear in the list. 

_Administrator should be part of the Administrators group. 

18. Select the Data Directories tab. 

19. Change the following directories: 

• Data root directory – Enter D:\DENTRIX_LIVE\. 

• User database directory – Enter D:\DENTRIX_LIVE\DATA. 

• User database log directory – Enter D:\DENTRIX_LIVE\LOG.  

• Backup directory – Enter D:\SQLBACKUPS\DENTRIX_LIVE. 

20. Select the TempDB tab. 

21. Add the following directory to the Data directories list: D:\DENTRIX_LIVE\TEMP. 

Note: This should be the only directory in the list. 

22. Click Next. 

The Feature Configuration Rules page appears only if there are rule errors. 

The Ready to Install page appears. 
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23. Verify that the information is correct, and then click Install. 

When the installation is complete, the Complete page appears. 

24. Click Close. 

25. Click the X in the upper-right corner of the SQL Server Installation Center window. 

Appendix A: Support Contact Information 
• Dell Pro Support – Covers Dell hardware. Call (866) 876-3355. 

• Microsoft support – Covers MS products. Visit https://support.microsoft.com/en-us. 

• Dentrix Enterprise support – Covers EDR/Dentrix Enterprise software. Call (800) 459-8067. 

• Tech Central – Can coordinate with all of the above. Call (877) 483-0382. 

 

https://support.microsoft.com/en-us
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B. MiPACS Dental Enterprise (Medicor 
Imaging) 

1. System Specifications for MiPACS Dental 

Enterprise PACS Components 
MiPACS Dental Enterprise PACS is a modular, scalable dental PACS that can be implemented in a 
number of ways, depending on the requirements and standard technology practices of an organization. 
MiPACS can be implemented on both physical hardware and as a virtual server (using any virtualization 
platform). Recommendations for both are included below, but we recommended that you consult with 

your MiPACS project manager for implementation recommendations for your particular environment. 

Medicor Imaging Software Versions 

The specifications provided below and on the following pages are for the following product versions: 

• MiPACS Storage Server v3.0.0.0 

• MiPACS HTML5 Web Viewer 3.0.0.0 

• MiPACS Dental Enterprise Viewer v4.1.0.0 

1.1 Server Requirements/Recommendations 

General Information and Requirements 

Environments where there are fewer than 50 concurrent DICOM connections can operate on a single 

MiPACS application server. A DICOM connection is defined as one of the following: 

• An active download of images from the MiPACS server 

• An active storage of images to the MiPACS Server. 

• An active query to the DICOM database or Modality Worklist. 

Viewing images, manipulating image content, measuring, and so forth do not count as DICOM 
connections. Only active DICOM uploads, downloads, and queries count as DICOM connections. 

Generally speaking, 50 concurrent DICOM connections is adequate for up to 1,000 users. 
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Hardware Specifications 

MiPACS Storage Server Minimum System Physical Configuration 

• Microsoft® Windows Server 2012, 2016, or 2019 (64-bit) 

• Microsoft® SQL Server Standard Edition 2012, 2014, 2016, 2017, or 2019 

• 2.4GHz Intel Xeon 6+ core processor 

• 16 GB RAM 

• 100 Mbps Network Adapter (1 Gbps highly recommended) 

• Microsoft® .NET Framework 4.0+ 

• Adequate storage for images (variable) 

MiPACS Storage Server Recommended Virtual Configuration 

• Microsoft® Windows Server 2012, 2016, or 2019 (64-bit) 

• 4 Cores 

• 16 GB RAM 

• Microsoft® .NET Framework 4.0 

• Adequate storage for images (variable) 

SQL Server Recommended Virtual Configuration 

• Microsoft® Windows Server 2012, or 2016 (32- or 64-bit) 

• Microsoft® SQL Server Standard Edition 2012, 2014, 2016, 2017, or 2019 

• 4 Cores 

• 16 GB RAM 

• Adequate Storage for database files (5 GB+, variable) 

MiPACS Storage Server MiniPACS Minimum System Configuration 

• <=10 Clients: Microsoft® Windows 7, 8, or 10 Professional (64-bit) 

• >10 Clients: Microsoft® Windows Server 2012, or 2016 (64-bit) 

• Microsoft® SQL Server Express Edition 2012, 2014, 2016, 2017, or 2019 

• Intel i3/i5/i7 processor 

• 8GB RAM or more (16 GB RAM recommended) 

• 100 Mbps Network Adapter (1 Gbps highly recommended) 

• Microsoft® .NET Framework 4.0+ 

• Adequate Storage for Images (variable) 
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MiPACS HTML5 Web Viewer Server Minimum System Configuration 

• Microsoft® Windows Server 2012, or 2016 (64-bit) 

• Microsoft® Internet Information Services 7+ 

• 8GB + 64MB memory per concurrent user (for example, 60 concurrent users would require 12GB 

RAM) 

• 8 core Xeon Processor (or more) 

• Microsoft® .NET Framework 4.0+ 

• A video card that supports DirectX 9+ must be installed on the Web server to enable hardware- 

based 3D rendering 

• Total number of concurrent users available for hardware rendering will vary depending on the 
field of view and resolution of each volume loaded at once, but generally speaking, 256MB RAM 

per expected concurrent user is a good target specification for the build-out of a new server 

• If no graphics card (or an underperforming graphics card) is available on the server, or if there is 
no remaining member on the graphics card, CPU rendering will be used 

• Recommended video cards (on server): 

• Nvidia GTX 1080 (8GB) 

• Nvidia RTX 2080 Ti (12GB) 

• There are no 3D graphics requirements on the client side (Web browser) 

 

Load Balancing the MiPACS Storage Server 

We recommended that you operate MiPACS in a load-balanced environment when there are more than 

100 concurrent DICOM connections to the MiPACS Application Server. You may use Microsoft 
Network Load Balancing (Windows Server 2003–2016), hardware load-balancing appliances, or virtual 
load-balancing appliances to spread the network load across multiple PACS Server nodes. Note that any 
load-balancing appliances must be able to forward the client IP to the MiPACS server as the 
originating/source IP address. This is typically accomplished by configuring the appliance to include the 

“Forwarded” and/or “X-Forwarded-For” HTTP header. 

Load Balancing the HTML5 Web Viewer Server 

The MiPACS HTML5 viewer may be load balanced but not clustered. You may use Microsoft Network 
Load Balancing (Windows Server 2003–2016), hardware load-balancing appliances, or virtual load-
balancing appliances to spread the network load across multiple Web server nodes. Note that any load- 

balancing appliances do not require identification of the originating client IP and can simply be load 

balanced as a standard service. 
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Clustering 

For environments using physical server hardware with high uptime requirements, you can implement 
MiPACS in an active/active cluster using Microsoft Clustering Services (Windows Server 2003–2016 
Enterprise Edition only). An active/active MiPACS cluster consists of two separate cluster resource 
groups: one for the MiPACS Storage Server DICOM services, and one for Microsoft SQL Server 
(Microsoft SQL Server Standard Edition or higher is required). We do not recommend that you cluster 
virtual MiPACS and/or database servers due to better and more responsive redundancy typically being 

built into the virtual platform infrastructure. 

1.2 Desktop Client Requirements/Recommendations 

The MiPACS client is a relatively lightweight client desktop application for Microsoft Windows 
operating systems. It has no prerequisites and can be installed on virtually any relatively modern 

Windows computer. 

4.1 or later MiPACS Dental Enterprise Viewer Minimum System Configuration 

• Microsoft® Windows 8/10 Professional (32- or 64-bit)* 

• Intel i3/i5/i7 Processor 

• 4 GB RAM (8 GB recommended) 

• 100 Mbps Network Adapter (1 Gbps recommended) 

• XVGA 1024x768 at 24/32 bit color (SXGA 1280x1024 recommended) 

• Monitor with at least 400:1 contrast ratio (800:1 or higher recommended) 

* Please note that capture devices may come with their own requirements, which are separate from the 
requirements of the MiPACS software. Please consult with the device manufacturer of each device for 

operating system compatibility. 

3.2 to 4.0 MiPACS Dental Enterprise Viewer Minimum System Configuration 

• Microsoft® Windows 7/8/10 Professional (32- or 64-bit)* 

• Intel i3/i5/i7 Processor 

• 4 GB RAM (8 GB recommended) 

• 100 Mbps Network Adapter (1 Gbps recommended) 

• XVGA 1024x768 at 24/32 bit color (SXGA 1280x1024 recommended) 

• Monitor with at least 400:1 contrast ratio (800:1 or higher recommended) 

* Please note that capture devices may come with their own requirements, which are separate from the 

requirements of the MiPACS software. Please consult with the device manufacturer of each device for 

operating system compatibility. 
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3.1.1404 or earlier MiPACS Dental Enterprise Viewer Minimum System Configuration 

• Microsoft® Windows XP/7/8/10 Professional (32- or 64-bit)* 

• Intel i3/i5/i7 Processor 

• 4 GB RAM (8 GB recommended) 

• 100 Mbps Network Adapter (1 Gbps recommended) 

• XVGA 1024x768 at 24/32 bit color (SXGA 1280x1024 recommended) 

• Monitor with at least 400:1 contrast ratio (800:1 or higher recommended) 

* Please note that capture devices may come with their own requirements, which are separate from the 
requirements of the MiPACS software. Please consult with the device manufacturer of each device for 

operating system compatibility. 

1.3 HTML5 Web Viewer Client Requirements/Recommendations 

The MiPACS HTML5 Web Viewer is a completely zero-footprint dental/medical viewer, which requires 
no installation of any applications, controls, or plug-ins. It functions within a Web browser only, so 

connectivity to the server is required for all operations. 

MiPACS HTML5 Web Viewer Minimum System Configuration 

• Any operating system (Windows, MacOS, Linux, iOS, Android, and so forth) 

• Any HTML5-compliant Web browser (Internet Explorer, Chrome, Edge, Safari, Opera, and so 
forth) 

• Access to the MiPACS HTML5 Viewer server requires at least a 1Mbps network connection 

Load Balancing 

The MiPACS HTML5 viewer may be load balanced but not clustered. You may use Microsoft Network 

Load Balancing (Windows Server 2003–2016), hardware load-balancing appliances, or virtual load-
balancing appliances to spread the network load across multiple Web server nodes. Note that any load- 
balancing appliances do not require identification of the originating client IP and can simply be load 

balanced as a standard service. 
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1.4 TCP/IP Port Communication Diagram 
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1.5 Network Specifications 

Configuration Minimum 
Bandwidth 

Recommended 
Bandwidth 

Clients directly communicating with server on 

same local network 
100Mbps 1000Mbps 

Clients directly communicating with server over a 

wide area network (local database–SQL or Access) 
10Mbps 50Mbps 

MiniPACS server communicating with central 

server over a wide area network 

1.5Mbps 10Mbps 

1.6 Data Backup Information 

• SQL Server database files (*.mdf, *.ldf) 

• MiPACS Storage Server image share folder 

• MiPACS Viewer image share folder 

1.7 Antivirus Exclusions: Files/Folders To Exclude 

• MiPACS Storage Server image share folder 

• MiPACS Viewer image share folder 

• C:\Program Files (x86)\MiDentView 

• C:\ProgramData\Medicor Imaging 

• X:\Medicor Imaging\MiPACS Storage Server 

1.8 Support Contact Information 

Phone: 704-227- 2629 

Website: https://medicorimaging.com/support/ Email: support@medicorimaging.com 

https://medicorimaging.com/support/
mailto:support@medicorimaging.com


34 MiPACS 

 
 

IHS EDR Technical Reference Guide 
 

2. MiPACS Dental Enterprise Viewer 4.0 Installation 
Instructions 

2.1 Labelling and Symbols 

 

Manufacturer: 

Medicor Imaging, Inc. 
1927 South Tryon Street, Suite 200 Charlotte, NC 28203 U.S.A. 
Tel: +1-704-227-2629 
Fax: +1-704-372-8161 
Email: support@medicorimaging.com 
Website: www.medicorimaging.com 

The date of manufacture appears in the software. 

 

Read all instructions before use! 

 

The catalog number is MiPACS Dental Viewer 4.0. 
Current product version appears in the software (MiPACS Dental Viewer 4.0.x). This 
version of the installation instructions is valid for product versions from MiPACS Dental 

Viewer 4.0.x. 

 

Warning! 
This symbol alerts the user to the risk of possible injury, death, or other serious adverse 
reactions. 

 

Caution! 
Instructions with this symbol must be followed in order to ascertain proper function of the 
equipment. 

2.2 Introduction 

MiPACS 4.0 is an image management software for dental practices. Before the MiPACS software 
products can be put to clinical use, you must properly install and configure it according to the installation 

instructions in this document. 

Installation and configuration is not intended to be performed by an end-user, but by an authorized 
MiPACS representative or an IT technician with experience in installing software and hardware for use in 

dental practices. 

Follow the “Installation Instructions” together with the “Instructions for Use.” Both documents are 
distributed with the software and are also available from the distributor or Medicor Imaging. Please refer 
to the Instructions for Use regarding product description, regulatory information, intended use and details 

regarding the user interface and clinical use of the product. 

Before installing and configuring software components, please consult sections 2.3 System Requirements 
and 2.4 Supported Equipment to establish that the product is suitable for the intended use and compatible 

with the available equipment. 

mailto:support@medicorimaging.com
http://www.medicorimaging.com/
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2.3 System Requirements 

Workstation System Requirements 

The recommended computer hardware for a workstation running MiPACS Dental Viewer 4.0: 

• Processor: Intel Core i3-compatible or better 

• RAM: 4GB 

• Disk: 40GB available 

• Network adapter: 1 Gbit/s 

• Screen resolution: 1280x1024, 32-bit color or better 

• A medical display monitor, (DICOM monitor) is strongly recommended. Alternatively, a high- 
quality display, properly calibrated, may be used if image rendering is considered acceptable for 

clinical use. 

MiPACS Dental Viewer 4.0 is supported on the following operating systems: 

• Microsoft® Windows 7, 32-bit or 64-bit 

• Microsoft® Windows 8.1, 32-bit or 64-bit 

For security reasons, the Windows operating system should be updated with the latest service packs and 

Windows updates. Use of antivirus software and firewalls is also recommended, but such software must 

be properly configured to not interfere with MiPACS and image transfer over the network. 

The “Instructions for Use” and the “Installation Instructions” (provided in this document) are installed as 

.pdf files that can be opened from the Start menu or in the application. To view these .pdf files, a PDF 

Viewer, such as Adobe Acrobat, must be installed on the computer. 

MiPACS can be installed with optional software modules (plugins) to connect MiPACS with third-party 
hardware (such as sensors and cameras), with software (such as other imaging applications or patient 

management systems), and with services (such as image transferring).  

The third-party hardware and software and the plugins may have different system requirements than those 
listed above. For example, some sensors may work in 32-bit Windows but not in 64-bit. Applicable 
additional system requirements for each plugin appear in Appendix B: Component-Specific Instructions. 
It is important to verify that any hardware that is to be used with MiPACS is supported by the plugin and 

that the driver version is compatible with MiPACS and with the operating system. 

Database Server and Network System Requirements 

MiPACS Dental Viewer 4.0 requires a database running on Microsoft® SQL Server 2012. It is not 

necessary to install MiPACS Dental Viewer 4.0 on the database server. 

For best reliability and performance, we recommend that you connect workstations and servers in an 
Ethernet network that utilizes network adapters, switches, and cables that support at least 1Gbps 

bandwidth. 

We recommend that you run MiPACS in a Windows domain, but the system can work on a single 
computer or in a peer-to-peer network as well. MiPACS can run in a terminal environment, but you must 

consider performance and hardware compatibility with imaging devices. 
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The network and server performance as well as storage space for the database server and backup system 
must be dimensioned for the expected workload. This is determined by the number of workstations in the 

network and the type and size of the images captured. 

Photographic images with high resolution are typically much larger than radiographs. 

User statistics show that a dental practice after five years has roughly 10-20 images per patient, which 
typically occupy 3-5MB per patient. For a medium-sized dental practice with 5-10 workstations, the total 

database size could reach about 50-200GB after five years. 

Based on these estimates, calculate the storage capacity that will be needed in the current environment 
during the lifetime of the server and storage system before upgrading server hardware and installing 

MiPACS. 

 

Caution! 

Follow the system requirements for server, network, and workstation performance! If there 
are reliability or performance problems when the system is accessed, there is a risk for 

delayed dental treatment. 

2.4 Supported Equipment 

MiPACS Dental Viewer can be connected to many third-party hardware and software systems used in the 
dental practice. Connection to X-ray devices, cameras, and other hardware is achieved through plugins 
that require separate installations. Transferring images as files or using Internet services is also achieved 

through plugins. 

Integration with patient management systems (PMS) is typically performed by the manufacturer of the 
PMS through an application programming interface (API) that is supplied by MiPACS. If such integration 
is not available from the manufacturer of the PMS, MiPACS supplies a few alternative methods of 

connection using software components, which are described in this document. 

The following sections provide a brief description of how you can connect supported equipment to 

MiPACS using the different types of plugins that are included with the software. 

X-ray Devices 

X-ray devices include intraoral sensors, phosphor plate scanners, and panoramic X-ray systems. 
Typically, different X-ray devices from the same manufacturer use a plugin with the name of the 

manufacturer. There are some exceptions, as noted in section B6. Dentalmind Digital X-ray II; for 

instance, a certain plugin works with equipment from different manufacturers. 

Below is a list of the X-ray plugins that are available with MiPACS Dental Viewer 4.0. If the 

manufacturer of the device is supported, refer to the relevant section for the plugin in Appendix B: 
Component-Specific Instructions for detailed information about that device’s compatibility with MiPACS 

and how to connect it. 

• Carestream/Kodak 

• Dentalmind Digital X-ray II 

• Dürr VistaEasy 

• ImageLevel NV SA MDX3 

• Instrumentarium 

• Kavo Gendex 

• Morita 

• Planmeca 

• Schick Intraoral (supports Schick and some Sirona sensors) 

• Sirona 

• Soredex (supports Soredex and some Instrumentarium devices) 
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Install the plugin and software that is supplied with the device, such as drivers with the correct version, 
according to the instructions in Appendix B: Component-Specific Instructions. After installation, refer to 

Chapter 9 in “Instructions of Use” from the applicable settings in the plugin, such as image enhancement.  

Important: Calibrate the imaging system according to the instructions in Chapter 10 before clinical use 

takes place. 

Intraoral Cameras 

MiPACS supports intraoral cameras from a variety of manufacturers. Most intraoral cameras and some 
other equipment, such as microscopes, use DirectShow drivers and can be connected through the Video 
plugin; however, there are some exceptions, such as Gendex intraoral cameras, which instead connect 

through the Gendex plugin. Some intraoral cameras connect through a TWAIN plugin (such as the 
Kodak/CS 1500) or Camera WIA plugin. See sections B19. TWAIN and B3. Camera WIA to determine 

which plugin to use for installing an intraoral camera. 

Many cameras have buttons on the hand piece for freeze/release and capture functions. Some intraoral 
camera models are only partially supported in the sense that all these buttons may not work but image 
capture almost always works. As an alternative to using the hand piece button,s the Video plugin also 

supports foot switches connected to either COM ports or game ports (emulated or real). 

Extraoral Digital Cameras 

Extraoral digital cameras can be used either in import mode or in direct capture mode: 

• Import mode – The images are imported from the camera memory card after they are taken. The 
import can be done by connecting the camera using a cable or memory card reader. All digital 

cameras support import mode. 

Import mode is achieved using the Camera WIA plugin or the Autoimport plugin. The Autoimport 
plugin is configured to point to a folder and automatically imports any files saved to it, optionally 

deleting them after the import. See section B.1 Autoimport. 

• Direct capture mode – The camera is connected to the computer with a cable or using Wi-Fi, and 
the image is imported into MiPACS directly when captured. Cameras supporting direct capture 

include most DSLR camera models like Canon EOS and the Nikon D series. 

Direct capture mode can be achieved using the Camera WIA plugin for most DSLR cameras (see 

section B3. Camera WIA). The exception is Canon EOS cameras, using the Autoimport plugin in 
combination with the “EOS utility” software from Canon. Refer to section B21. Canon EOS Direct 

Capture for instructions on configuring the Canon EOS Utility for use with MiPACS.  

Flatbed and Film Scanners 

Flatbed scanners and film scanners can be used to scan analog radiographs and photographs and to import 
documents as images into MiPACS. Flatbed and film scanners usually have a TWAIN driver and can 

therefore be connected through the TWAIN plugin. 

For occasional use, scanning may also be performed directly from the application without a plugin by 
using the Acquire option in the Import dialog box. Please refer to “Instructions for Use” for more 

details. 
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Image Transfer and Communication 

The MiPACS application contains features for importing and exporting image files (see “Instructions for 
Use” for more information). If the users often import files from the same folder or removable storage 
device, such as the memory card from a digital camera, you can make the workflow easier by setting up 
the Autoimport plugin or Manual Import plugin. Similarly, the Export plugin can be used to simplify file 

export to a specific folder. 

Files can be transferred over the Internet using services such as C-Takt Link and Medspace. To use a 
service, install the C-Takt Link or Medspace plugin, and configure the plugin with the account login 

information for the service (refer to sections B5. C-Takt Link and B13. Medspace). 

 

Caution! 

Install only compatible hardware and software combinations, and verify that the system 

works after installation! If unsupported hardware or software components are installed, the 

system or the component may not work, which may delay dental treatment. 

2.5 Installation 

The MiPACS 4.0 software is distributed as a single executable file that contains a self-extracting installer 
package. The package contains the MiPACS application, all available plugins and software tools, and 
documentation in all the supported languages. The installer package is available for download from the 

manufacturer's website (www.medicorimaging.com) or can be supplied through authorized distributors. 

Every MiPACS 4.0 installer package is labelled 4.0.x, where x is a version number. The name of the 
executable installer is MiPACSSetup4.0.4.exe for the first version of MiPACS 4.0.4 and similar for 

future versions. Do not change the file name of the installer package, or else the installer will not run. 

You can install components only from one package version. The package configuration is tested and 
verified. Attempts to mix components from different versions of MiPACS will cause the installation to 

fail. It is not possible to install MiPACS 4.0 on a computer with a previous version of MiPACS already 

installed until you completely remove the previous version. 

If the MiPACS configuration becomes corrupted, or if components with wrong version number are 

detected, the application will alert the user with a message stating “NOT FOR CLINICAL USE.” In that 

case, uninstall MiPACS and all components completely, and reinstall them from a valid installer package. 

http://www.medicorimaging.com/
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In order to run the installer, you must have administrator rights in Windows. When started, the installer 
displays a list of the available components. Select MiPACS Dental Enterprise Viewer 4 to install the 
application, and select the plugins that are needed to connect the equipment attached to the computer (see 
Chapter 4 in “Instructions of Use” and the relevant section in Appendix B: Component-Specific 

Instructions). 

 

You must run the installer on every workstation on the network. Often, different components are installed 
on different workstations depending on the equipment in the treatment room. In large organizations, it is 

possible to automate the workstation installation. Contact Medicor Imaging for more information. 

It is possible to re-run the installer at a later time to add components that were not selected previously. All 
components that are selected in the list will overwrite previously installed components. This way, it is 
possible to reinstall the application or components if the installation has become damaged. The installer 
will not uninstall components if they are deselected. The application and all components can be 

uninstalled from Apps & features in the Settings window in Windows. 

No hardware drivers or other third-party software that are needed to connect specific equipment is 

included in the MiPACS 4.0 installation package. You can download drivers and other software from the 
equipment manufacturer's website if those are not included with the equipment. Install drivers only with 
the correct version number according to the relevant plugin section in Appendix B: Component-Specific 

Instructions. 

 

Caution! 

Install only tested software configurations, and verify that the system works after 
installation! If components such as plugins or drivers have a different version than those 
listed in the installation instructions, the system or the component may not work, which 

may delay dental treatment. 
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2.6 Database Setup 

The MiPACS Dental Viewer database consists of two parts: an SQL server database that stores patient 
information and image metadata and a directory structure in Windows that contains the image files 

belonging to each patient. 

The SQL server database and image store typically reside on the same server for small- and medium-sized 
installations. In large organizations, it may be desirable for performance reasons to separate the server 
roles and place the image store on a Storage Area Network (SAN), possibly combined with clustering of 

database servers and/or storage servers. 

In MiPACS Enterprise installations, redundant storage can be provided by a DICOM storage server. In 
such installations, additional redundancy can be obtained if the DICOM storage server cluster is 

physically separated from the MiPACS database servers. 

 

Caution! 

Setup database and network combinations that have been tested according to the installation 

instructions. If the image database connection is lost, dental treatment may be delayed. 

SQL Server Installation 

The MiPACS database requires Microsoft SQL Server. It is available in different editions for large and 
small organizations and the SQL Server Express edition is available for download at no cost. See 

https://www.microsoft.com/en-us/server-cloud/products/sql-server/ for more information. 

Planning and configuration of a large SQL Server installation could be a complex task. Database 

administrators may contact Medicor Imaging for assistance before deployment. 

For small- and medium-sized dental practices, it is possible that SQL Server Express may suffice. The 
following sections provide a short description of SQL Server Express setup for a small- or medium-sized 
installation. The description illustrates the general concepts, but SQL Server installation is otherwise 

beyond the scope of this document. It is the responsibility of the installer or database administrator to 

install and configure the database server according to the needs of the organization. 

SQL Server Express Installation and Setup 

Download and run the SQL Server Express with Tools installer. This version contains SQL Server 

Management Studio, which may be needed for maintenance tasks such as restoring backups. 

Create Server Instance 

The installer will ask for the instance name to set up: 

• Default instance – “MSSQLSERVER,” which will allow connections using just the server name. 
You can use the default instance if this is the only instance on the server. 

• Named instance – The default named instance is “SQLExpress.” If the server already runs existing 
SQL Server instances, such as for a patient management system database, we recommend that you 
create a separate instance for MiPACS by changing the named instance to “MIPACS” or something 

similar.  

https://www.microsoft.com/en-us/server-cloud/products/sql-server/
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Server Configuration 

Change the setting for Authentication mode to mixed mode to allow Windows authentication as well as 

enabling the administrative user “sa” login. Choose a password for the “sa” user. 

Important: Write down the selected "sa" password, and store it in a secure location. The password will 

be needed later to create and restore database backups. 

Accept Incoming Connections 

This step may not be needed for a single-user installation where MiPACS and the SQL Server database 

are stored on the same computer. 

In SQL Server Configuration Manager, configure the server to accept incoming connections. Select 

Network Configuration and Protocols. Enable the options TCP/IP and Named Pipes. 

Restart the SQL Server service. Make sure that it starts and that the SQL Server Browser is running. 

Incoming client connections may be blocked by the Windows firewall or by a third-party security 

application. Make sure that the necessary ports are open in the firewalls. 

If database access uses Windows authentication, you must properly configure all MiPACS user accounts 

with read and write access rights to the SQL Server. This is easier to maintain in a Windows domain 

environment. 

Image Store Setup 

The image store is a shared directory on a server. The image store server can be the same server as the 
one running SQL Server or a different server on the network. The image files can be located on the 
workstation itself for single-user systems (in which case, there is no need to share the folder on the 

network). 

MiPACS will create the directory structure in the share when the database is created. First, create the 
share, and set the user access rights. All MiPACS users (domain users or local Windows accounts) need 

both read and write access rights to the image store directory structure at the operating system level. 

You should make the image store path available to all clients through a UNC path (in a 
\\SERVER_NAME\IMAGE_STORE_SHARE format). We do not recommend that you use a mapped 
drive in the path (such as X:\ImageStore). Such mappings are user-specific and may not be available 

when the application is run as an administrator. 

The image store path is stored in the SQL database. If the SQL database is moved to a new server, or if a 

backup is restored in a new environment, you must change the image store path to the new location. 

 

Caution! 

Configure the network settings properly according to the installation instructions. If the 

system or a component does not work, dental treatment may be delayed. 

Database Creation 

To create a new database, start MiPACS on a workstation. On the System menu, select Create new 

database. Under Server name, enter one of the following: 

• If a named SQL Server instance was installed, enter the name of the server and instance in a 
SERVER_NAME\INSTANCE_NAME format. 
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• If a default SQL Server instance was installed, enter only the server name. 

Enter a name for the new database, such as MiPACS_Viewer. Select the path to the image store share 
configured previously (\\SERVER_NAME\IMAGE_STORE_SHARE). Click OK to create the new 

database. 

An SQL Server login dialog box appears. As the user name, enter sa, and enter the password that was 
selected during the SQL Server installation. You can also select Windows authentication, for instance, in 
a Windows domain environment with domain users properly configured with access rights to the SQL 

Server. Click OK. 

Database Selection 

To connect to an existing database, for example, when adding a new workstation to the network, first start 

MiPACS on an existing workstation, and then select Database information on the System menu. This 
will show the existing server instance name and the image store path. Note the information and use it 

on the new workstation. 

 

On the System menu, select Connect to existing database. Enter the SQL Server authentication 
parameters. Under Server name, enter the name of the SQL Server instance where the MiPACS database 

is stored. If the client can connect to the server, a list of databases on the server appears in the list. Select 
the correct database in the list. The image store path stored in the database appears and can be changed, 
such as for migrating or restoring a database to a new environment. Click OK to connect to the existing 

database. 

If the SQL Server or the image store cannot be reached from the new workstation, check the network 
settings, and verify that any firewall software in the server and/or the workstation is configured to allow 

connections. 

 

Caution! 

Configure the database settings properly according to the installation instructions. If the 

system or a component does not work, dental treatment may be delayed. 
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Database Backup 

 

Caution! 

Configure a system that creates regular backups of the SQL database and image store, and 
verify that the backup system works. If the image database is lost, dental treatment may be 

delayed. 

 

It is essential to create regular backups of the SQL Server database as well as the image store files. You 
must perform backups daily or even more frequently and transfer them to an off-site location. Third-party 

backup software is commercially available and is capable of backing up a SQL Server database as well as 
any other data stored at the practice, such as the patient management system database. In some editions of 
SQL Server, it is also possible to schedule automatic backups using the SQL Server agent in Management 

Studio. 

If such options are not available, a simple SQL Server backup script is included with the MiPACS 
installation. After manual configuration, you can use command-line tools to create a SQL database 

backup to a file that can then be copied to the backup media by any file-copy tool. 

The sqlbackup script is located in the application folder in the Program Files directory. Configure the 
script according to instructions in section B22. SQL Backup Script, and then schedule it to run regularly 

with Windows Task Scheduler. 

The script will create a SQL backup file (such as MiPACSDB.bak) in the desired folder, which is 
C:\MiPACSBackup on the server by default. The whole MiPACS patient database is then backed up or 
moved to a new server by copying the .bak file and the entire contents, including subfolders, of the image 

store folder. 

Move or Restore Database 

If the patient database is destroyed or corrupted, possibly due to a database server crash or a fire, it may 

be necessary to restore the most recent existing backup. 

When performing a planned migration to a new server, start by creating a fresh backup according to the 

aforementioned instructions. The backup consists of the following: 

• A .bak file (named MiPACSDB.bak or something similar) that contains the backup of the SQL 
database 

• The entire image store directory structure, including files and subfolders. 

Install a new SQL Server, and set up a new image store share according to the aforementioned 
instructions. Next, use Management Studio to restore the .bak file, and copy all the image store contents 

to the new location. Make sure that all users have read and write access rights in the new image store. 

Launch MiPACS on a workstation. Select Connect to existing database on the System menu, select the 

database on the new server, and then click OK to verify the connection. Select Connect to existing 

database on the System menu again, change the image store path in the restored database to the correct 
path of the new image store location (do not click Add to create a second image store folder), and then 

click OK. 

Test the restored or migrated system by accessing patients and old images on all workstations. Verify that 

image capture still works. 
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2.7 Application Setup 

 

Caution! 

Application settings must be set carefully according to the instructions and to the current 
clinical environment. If the settings are wrong, there is a risk of misdiagnosis or 

malpractice. 

 

Most of the settings in the main MiPACS Dental Viewer application are accessed from the Preferences 

dialog box, which are accessed from the System menu. The dialog box consists of a number of tabs with 
different groups of settings. The settings are sometimes stored in the common database and thus affect all 
users and all computers. Other settings are stored in the registry and affect either the local computer or the 

currently logged in user. 

In order to save some settings after changing them in the Preferences, Windows administrator rights are 
needed. If User Access Control (UAC) is turned on, you must start the application by right-clicking the 
MiPACS 4.0 icon and then selecting Run as administrator. When a user opens Preferences, a warning 

message alerts the user if settings cannot be saved because the user lacks administrator rights. 

The following sections provide a short description of the tabs in the Preferences dialog box. Some of the 
settings are described in greater detail in the following sections. Only the first tabs (User and License) are 
available to end-users. To access the other tabs, you must first click Advanced, and then confirm the 

warning message. 

User 

These settings are intended for end-users and control the language and user-interface appearance for the 

current user. There is also an option to reset the menus and toolbars if they become corrupted. 

License 

On this tab, you can view and manage license keys stored in the database. See Chapter 8 in the 

“Instructions of Use” for more information. 

General 

You can configure referrer settings that affect how the system prompts for a referrer during capture. A 

referrer is a person who requests images and who is later responsible for approving them. 

Integration 

These settings control the connection to some patient management systems (PMS). For instance, it is 

possible to disable the built-in patient edit and search functions when a PMS is used. 

Display 

Settings that control the rendering of images on the computer screen. Use these settings with caution, and 

remember that monitor calibration may be affected (Chapter 10 in “Instructions of Use”). 
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Capture 

On this tab, there are settings for image enhancement and other processing, such as mirroring, which will 
be applied on images after they are captured with a specific plugin but before they appear in MiPACS. 
You can apply individual processing to different image sources. Do not use additional image 
enhancement here if it is already applied in the plugin settings. See Chapter 9 in “Instructions of Use” for 

more information. 

Security 

These settings control the login method, user access rights, access to DICOM storage servers and 

Modality worklist servers. 

 

The settings on the Security tab control access rights within MiPACS for different users or groups of 
users. By default, the login name in Windows is used for logging in. This can be changed to AD login for 
Windows domains or Application login for peer-to-peer networks. If these settings are used, there is no 
need to log out of Windows to change users, and MiPACS presents a login prompt when the application 
is launched. In this setup, you can also configure MiPACS to use swipe cards for logging in and 

approving images. 

You can modify user access rights for the Default user, which affects new users that are added, or you 
can modify rights separately for each existing user or a group of users. Select a user in the left list, and 

then select the checkboxes to the right to control access to various features. 

The installer or administrator that changes permissions for other users must have the “Administrate 

security” right. However, once a user with this permission has been added, you should remove the 

“Administrate security” right from the Default user and any ordinary users. 
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The user permissions are dependent on the workflow and roles of the users and should be decided 
together with a clinic manager or responsible dentist. See the “Instructions for Use” for more information 
about how user permissions affect the functionality of the application. For instance, an assistant that 
captures images but is not allowed to diagnose can have permission to edit, capture and import images; 

and a dentist can have the same permissions and permission to approve and export images and possibly to 
delete and crop. The “Unapprove images” right should be reserved for a clinic manager or system 
administrator and possibly only activated on a temporary basis. This is especially important in MiPACS 
Enterprise installations. Unapproving approved images is not a routine task and should only be done if the 

approval was made by mistake. 

Installers and IT technicians need to have the “Administrate application” and “Administrate plugins” 

rights to change the settings in Preferences and plugin settings. 

 

Caution! 

Configure the security settings properly according to the installation instructions. If the 

system or a component does not work, dental treatment may be delayed. 

Image Format 

These settings control the image file format in the MiPACS database. The choice of file compression 
affects the size of the image files and the database but can also decrease the image quality. This setting 

affects all users and should be changed with caution and only if necessary. 

DICOM 

(For MiPACS Enterprise Only) 

 

With the settings on the DICOM tab, you can configure a client to connect to one or several DICOM 

storage servers. Configure each server by entering its AE title, IP address, and port number, which you 

can obtain from the DICOM server administrator. When configuring the connection, make sure that the 

right network adapter on the client is selected if there are several adapters installed. 
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Multiple servers may be selected for DICOM Query and are then available for searching patients, but 
only one may be used for storage. In some environments, we recommend that you configure all clients 
with DICOM Query only (no DICOM Store) and instead setup asynchronous batch transfer of approved 
images from the MiPACS database server to the DICOM storage server as a scheduled job performed 

daily or weekly. Unapproved images may be approved and transferred at a later stage with the List 

unapproved series tool. 

To access a DICOM server, the client must be configured with a unique Client Application (AE) title 

and Client Port number. The same information needs to be entered into the DICOM server by the server 
administrator. After configuring the client AE and port, you can test the connection to each storage server 
by selecting the server in the list and then clicking Test Connection. On this tab, you can also enable 

Modality Worklist Query and configure the MWL server settings. 

 

Caution! 

Store all images in the MiPACS database as well as in the DICOM server for redundancy. If 

historic images or data are lost, there is a risk of decreased diagnostic capability. 

2.8 License Management 

After MiPACS 4.0 is purchased, an installation license is created for a certain number of workstations. 
This is controlled with a license key that is entered on one of the workstations and stored in the database. 
When the license is renewed or if the number of workstations needs to be increased, a new key is 
distributed. A list of the license keys stored in the database and their type and expiry date appears on the 

License tab in the Preferences dialog box. 

The license key is a text file that contains the name of the practice and a code string. When a new license 
key is distributed by email, double-click the license file to import it into MiPACS. If the license file is 
unavailable, on the License tab in the Preferences dialog box, enter the code string exactly as shown. If it 

fails, be aware that some letters and digits may look similar (such as 1/I/l and 0/O). 

2.9 Plugin Setup 

 

Caution! 

Configure the imaging hardware settings properly according to the installation instructions. 

If the system or a component does not work, dental treatment may be delayed. 

 

Run or re-run the package installer to select and install the plugins needed to connect the desired 
equipment to the workstation after determining that the equipment model is supported and the system 
requirements fulfilled (refer to the relevant plugin section in Appendix B: Component-Specific 

Instructions. 

When a plugin is installed, it appears in MiPACS as an extra toolbar. On the Tools menu, select Plugin 

options to enable or disable selected plugins. The settings for each plugin can also be accessed from the 
Tools menu. This requires the user to have the “Administrate plugins” security right (see Chapter 7 in 
“Instructions of Use”). In the settings dialog for each plugin, there are parameters that may need to be 

adjusted. 
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Video Plugin 

For the Video plugin, the intraoral camera model or connection method is selected, possibly with 
additional parameters according to the plugin in section B20. Video and the camera manufacturer’s 

instructions. If the camera buttons do not work, you may also configure a foot switch in the Video plugin. 

 

Camera Plugins 

For cameras, we recommend that you set up auto-selection of a certain template when images are 
captured so that photographs are not placed in an X-ray template. On the Capture tab of the Preferences 
dialog box, select the plugin used for camera capture, select the Use auto-selected template checkbox, 

and then select a suitable template, such as PA5 or PA9. 

 

X-ray Plugins 

For several X-ray plugins, the devices connected to the workstation can be specified, sometimes with 
additional settings for each device. Review and adjust these settings according to the plugin instructions 

in Appendix B: Component-Specific Instructions and the instructions from the device manufacturer. 

Some X-ray devices need to be activated before capture. Once a plugin is installed, on the Capture tab of 
the Preferences dialog box, you can configure automatic activation of a specific device when a patient 

record is opened. 

The X-ray plugins also have image enhancement options. Adjust these accordingly. For these plugins, 

there is also an option to reduce the image quality an image is stored in MiPACS. 
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Image enhancement can be applied in several steps of the capture chain: 

1. By the driver – Some drivers use image enhancement filters that sometimes cannot be disabled. 

2. By the plugin – On the Capture tab of the Preferences dialog box, image enhancement and similar 

options can be configured. 

3. By the user – The user may add image enhancement during analysis with the tools in the program. 

Some enhancements, such as noise reduction and edge enhancement, are destructive and can degrade the 
image quality, especially if they are applied repeatedly. We therefore recommend that image 

enhancement be applied in only one of the steps in the capture chain, and having images enhanced by the 

plugin is preferred. 

Reduction of image quality should be applied after image enhancements for best results. If users prefer to 
perform extensive image enhancement in the program, disable reduction of image quality in the plugin 

settings. Images will then consume considerably more storage space. 

 

Caution! 

Verify that the image acquisition chain works after installation! If the system or a 

component does not work, dental treatment may be delayed. 

Image Enhancement 

 

Warning! 

Adjust image enhancement settings carefully according to the instructions, and have a 
dentist verify them before they are put into clinical use. Incorrect settings could lead to 

inferior image quality and misdiagnosis or malpractice. 

 

Each X-ray plugin has individual image enhancement settings which can be applied to all new images that 
are captured with the connected device. Some plugins support more than one type of device, such as 

sensors and scanners, and may then have separate enhancement settings for each device. 

In the image enhancement dialog, change the settings, and then click Update preview to see the result. 
Compare the enhanced image to the raw image. Test different settings until the image quality is sufficient 

to perform accurate diagnoses. 

Important: This step requires the approval of the dentist! 

To start over from the default settings, click Defaults. Click OK to save the settings or Cancel to close 
without saving. Resize or maximize the window to get larger images. Click an image to switch between 
displaying the full image or a zoomed-in view. Press the plus sign key (+) to zoom in and the minus sign 

key (-) to zoom out. 
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Histogram Adjustments 

 

Often, images are too bright and have poor contrast. You can improve this by reducing the Gamma 

correction value to approximately 0,5 to 0,8. You can brighten dark images by increasing the gamma 

value above 1. Gamma = 1 corresponds to an unchanged image. 

As a final step after calibrating the X-ray chain, you can enable Histogram stretch to obtain optimal 

contrast. Adjust the limits for Upper histogram cut and Lower histogram cut to stretch the histogram. 
0% to 2% is usually enough. The Equalize histogram option offers even more contrast but can make the 

image look distorted. Use this option with caution. 

Noise Reduction 

Sometimes you can reduce the noise in an image by selecting Noise reduction, which will apply a 
median filter on the image. You can adjust the degree of noise reduction by using the Mask size. If the 
smallest mask size (3x3) does not remove all noise, try a slightly larger size, such 5x5 or 7x7. Note that 
overly large masks are destructive for the image details. You can set a small threshold value with the 
Threshold slider to reduce unwanted side effects of the noise reduction. Use this filter with caution since 

small details in the image may be lost, especially with large mask sizes. 

Sharpening 

The Sharpen image option can enhance the perceived sharpness of the images. An “unsharp mask” filter 

will then be applied, and the three parameters may need adjusting to get a good result. The degree of 
sharpness is set by the Amount. 20-50 is often enough. You can also increase the sharpness by selecting a 
larger Mask size. The best result is obtained with a small mask size and a moderate amount. Too much 
sharpness will introduce artifacts in the image. Sharpening will also amplify noise in the image; therefore, 
noise reduction is often used in conjunction with sharpening. In addition, you can raise the Threshold 

value slightly for the sharpening filter to further reduce the noise effect. A threshold of 2-10 usually 

provides sufficient noise reduction. 
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Important Note about Destructive Image Operations 

Please note that the image enhancement functions in the plugin settings perform irreversible operations on 
all captured images. The filters distort information and may even add misleading effects that were not 
present in the original image, and there is no way to recover the original image after permanent image 
enhancement has been applied. Use the image enhancement filters with caution and realize that an image 

with good appearance may not be optimal for diagnostic purposes. 

2.10 X-ray Imaging System Calibration 

 

Warning! 

You must properly calibrate the X-ray imaging system before it is put into clinical use. 

Inferior image quality could cause misdiagnosis or malpractice. 

 

You must calibrate every X-ray imaging system before it is used for diagnostic purposes. You must also 
check the imaging system regularly to verify that it does not deteriorate, due to aging of the X-ray source 

or due to inadvertently changed settings. 

The term “X-ray imaging system” here includes the whole chain of components, each of which may 

affect image quality: 

• The X-ray source. 

• Imaging devices such as sensors and scanners. 

• Drivers, which sometimes contain image enhancement algorithms. 

• MiPACS plugins with image enhancement filters. 

• The MiPACS application and other imaging software. 

• The computer monitor, where the dentist interprets the result. 

Before you calibrate the X-ray imaging system, it is important that the X-ray source is in good condition 
and functioning properly. The performance of the X-ray source must be verified by regular dose 

measurements. This should be performed by the distributor of the X-ray source. 

If a new X-ray imaging system is installed or any of the components in the system are replaced, you must 

calibrate the imaging system. The calibration includes adjusting the exposure time of the X-ray source to 
obtain optimal image quality from sensors and phosphor plates while minimizing the X-ray dose to 
patients. In addition, this includes configuring the image enhancement settings in MiPACS and/or 

hardware drivers and calibrating the computer monitor for correct rendering of X-ray images. 

Refer to the following checklist for calibrating the X-ray imaging system after new hardware is installed 

or some part of the system is replaced: 

1. Install the X-ray sensor or phosphor plate scanner according to the manufacturer’s instructions. 

2. Follow the plugin installation instruction in the relevant section of Appendix B: Component-

Specific Instructions. 

3. Calibrate the monitor as described in the next section. 
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4. Go to System > Preferences > Capture. Select the correct plugin under Select source. Turn off all 
image enhancements; deselect all options in the list, and disable gamma correction (set gamma = 

1). Click OK to save the settings. 

5. Open the plugin settings from the Tools menu. Click Image enhancement options, and disable all 
settings explained previously. If the Save image copy for enhancement preview option is 

available in the plugin settings, make sure it is turned on. 

6. Sometimes there are also settings in the driver software that gets installed with the device that may 
affect the image. Check the manufacturer's instructions on how to calibrate and optimize such 

settings before moving on. Disable image enhancement in the driver if possible. 

7. Capture a test image under realistic clinical conditions. Use an imaging phantom or ideally real 
teeth, and expose an image using the recommended X-ray exposure time according to the device 

manufacturer's instruction. 

8. In MiPACS, open the Histogram tool, and check that the grayscale content of the image is within 
the boundaries of the histogram. Optimally, the main peak should be centered in the range, but 

sometimes the dynamic range of the device is so wide that the content is in a narrower part. If the 
grayscale content looks like it is partly outside the histogram range, adjust the X-ray exposure time 
accordingly and capture a new image. Repeat these steps until a good exposure is made. Write 
down the exposure time, voltage, and other parameters that are set on the X-ray source, and use 

them as the standard for future captures. 

9. Go to the plugin settings again, and turn on the image enhancements (see Chapter 9 in “Instructions 
of Use”). In the image enhancement dialog box there is now a preview of the last image captured. 
Use it to adjust the settings for optimal image quality. It is the responsibility of the dentist to 

approve the final image quality. 

10. When done, click OK in the image enhancement dialog box, and click OK in the plugin setup 

dialog box to save all settings. 

11. Restart the computer, and capture another image to confirm that all settings were saved and that the 

image quality is still good. 

12. The image quality shall be approved for diagnostic use by the dentist. Use the approval form in 

Appendix C: Installation Approval Form. 

Note: Image enhancement settings may cause loss of information and/or introduction of artifacts in 
the image. This could decrease the diagnostic value of the image. Use the settings with caution, and 

do not turn on settings unless the dentist determines that they aid in accurate diagnosis. 

Monitor Calibration 

 

Warning! 

You must properly calibrate the computer monitor before it is put into clinical use. Inferior 

image quality could cause misdiagnosis or malpractice. 

 

It is important to calibrate the computer monitor to make sure that X-ray images are displayed accurately. 
With incorrect settings, important clinical information may be lost in the darker or lighter parts of the 

image. Incorrect settings may also cause distorted image proportions. 
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Also consider the lighting conditions of the room, and the fact that the monitor orientation with respect to 

other light sources and the viewing angle may affect the perception of images on the monitor. 

It is very important to use a high-quality computer monitor. We strongly recommend that you use a 
monitor designed to display medical grayscale images (sometimes called a DICOM monitor). Sometimes 
such monitors are factory-calibrated, and the settings cannot be changed; in other cases, special software 
and/or hardware must be used for calibrating the monitor. Refer to the manufacturer's instructions. The 
computer's graphics adapter must be installed with the proper driver and set to the correct resolution 

based on the monitor specification. Also, check that it is set to at least 24-bit color depth. 

MiPACS’s Monitor Calibration tool (which you can access from the System menu) can facilitate the 

calibration and regular checkup of the monitor. It displays a test image for you to use when adjusting the 
display for optimum image quality. Each monitor calibration that you perform is logged with the date and 
time, workstation, the user who performed the calibration, and any comment made. By default, the 
Monitor Calibration tool shows a list of all monitor calibrations that were made at the current workstation. 
Selecting the Show calibrations for all workstations checkbox allows you to see calibrations that were 

performed at all workstations that are connected to the same database. 

Click Perform new calibration to show the test image. 

 

Adjust the brightness, contrast, and other settings of the monitor so that it is possible to distinguish the 
fields inside the boxes at the bottom left and right that are marked 5% and 95%. Check that all shades of 

gray are correctly displayed. 

Verify that the proportions are correct. Boxes with gray shades should be squares, and there should be a 
circle in the middle. Use a ruler to measure that the height and width of the circle are equal. If the 

proportions are not correct, the resolution of the monitor or graphics adapter is not configured properly. 
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Consistency Check 

To maintain the calibrated state of the X-ray imaging system, you must use MiPACS’s Consistency check 

tool (which you can access from the System menu) to perform and document regular consistency tests. 

This tool opens a record, similar to a patient record, with the name “Consistency check.” You can display 
and store images as usual. Perform the consistency check as a fixed routine with certain periodicity, each 
time with the same X-ray exposure time, imaging phantom, and distance between the phantom and X-ray 
source. Check that the image quality has not deteriorated since the last time. If it has, it means that some 

component of the capture chain has changed for the worse. 

When you capture images during a consistency check, the average grayscale value of the image is 
automatically saved as an image comment. This value normally appears in the lower-right corner on the 
status bar when you select the image. Also, you can use the Color Probe tool (Image > Color/Gray-

levels) to check the grayscale in various parts of the test image. Enter the measurements as comments. 

Please note that there is only one consistency check record in the database, so you should save each image 

series with a unique name for each workstation (such as the name of the treatment room). 

When you perform the consistency check, it is important that all image enhancement filters that can hide 
any X-ray imaging system deterioration are turned off wherever possible in order to get an accurate 

picture of the state of the capture chain. Some image enhancement functions can compensate for bad 

exposures, such as Histogram stretch, so you must disable them during the consistency check. 

Sample routine for consistency check: 

1. Go to System > Consistency check. 

2. Go to System > Preferences > Capture. Select the correct plugin under Select source. Turn off all 
image enhancements, deselect all the options in the list, and disable gamma correction (set gamma 

= 1). Click OK to save the settings. 

3. Open the plugin settings from the Tools menu. Click Image enhancement options, and disable all 

settings explained previously. 

4. Sometimes there are also settings in the driver software that get installed with the device that may 
affect the image. If such settings are enabled, make sure they are set equally at each consistency 
check session. At least turn off functions that would hide changes in exposure like histogram 

stretching or automatic grayscale leveling. 

5. Capture a few images with different exposure times using the X-ray phantom. 

6. Check the average grayscale value (in the status bar): measure the grayscale in different parts of the 
image with the Color Probe tool, and check the histogram. Compare this with previous checks made 

under the same circumstances, and note any differences.  

7. Restore all settings to the way they were before the consistency check.  

8. If you observe deterioration in the system, troubleshoot it to determine the cause and take corrective 

action. 
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2.11 Patient Management System Integration 

Patient management systems (PMS) are generally adapted to work with MiPACS by the PMS 
manufacturer. Once a PMS is installed, configuration of the PMS might be needed to connect it to 
MiPACS so that it is possible to open a patient in MiPACS (for example, by clicking a button in the 

PMS). This is usually performed by the distributor or installer of the PMS. 

If there is no integration to MiPACS that is built into the PMS, a couple of tools are supplied that you can 

use to set up a connection between the PMS and MiPACS: 

• Patient Selector – A configurable tool that you can set up to read patient information from the 

window of the PMS. Documentation for this tool appears in section B23. Patient Selector. 

• Command line link – An interface to MiPACS. Documentation for this tool appears in section 

B24. Command Line Link. 

2.12 Templates 

 

Warning! 

Create user-defined templates carefully according to the instructions, and a dentist must 
verify them before they are put into clinical use. If there is an error in a template, there is a 

risk of misdiagnosis or malpractice. 

 

Use templates to arrange images for diagnosis and to assign anatomic information to images. In addition 
to the built-in templates in MiPACS, you can create new templates from scratch or by modifying existing 

templates. Also, you can export and import files containing templates. You cannot delete the built-in 

templates, but you can hide them from the menu. 
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Do the following: 

1. On the Window menu, select Edit templates. 

2. Either select an existing template in the list pane and save it with a new name using Save As, or 
start with an empty template and add frames using Tools > Add image frame to template. Arrange 
the frames, and adjust their sizes by dragging the corners. To view gridlines, select Show/hide grid 

on the Tools menu. 

3. Under Properties in the list pane, enter the Sequence number, Frame number, Proportions, and 
Rotation correctly. The sequence number controls the order in which captured images are placed 
into the frames. Proportions control the aspect ratio of images by masking off a section of the 

square frame. 

4. Also, enter correct Anatomic information for each frame. The Laterality, Region, and Modifier 

information will be filled in according to the selected Anatomic Description. 

5. Click Save to save the new template. 

6. Go back to Properties, and give the template a type, such as Intraoral or Secondary Capture. 

Important: All template settings must be verified by the dentist before clinical use. 

7. After a dentist approves the template, click Save to save the new template in the database and make 

it available to all workstations. 

2.13 Upgrading from a Previous MiPACS Version 

It is not possible to install MiPACS 4.0 if an older version, such as MiPACS 3.1, is already installed on 

the computer. You must first uninstall MiPACS 3.1 for the MiPACS 4.0 installer to run. 

Before uninstalling an older version, we recommend that you write down important settings in the old 
system, especially database settings and plugin settings, such as image enhancements. All settings are 

reset to default values when you install MiPACS 4.0. 

A major part of equipment, such as sensors and cameras, currently in use by MiPACS 3.1 users is 
supported with the set of plugins included with MiPACS 4.0. In future releases, support for additional 
equipment will be added as soon as possible. However, some legacy hardware that was supported in 
MiPACS 3.1 may not be supported in MiPACS 4.0 (this is determined by the number of users and the 
system requirements of the legacy equipment). For instance, the drivers for some older sensors only work 
on Windows XP, which is a deprecated operating system. In such cases, it is necessary to replace the 

hardware with a modern alternative before you upgrade to MiPACS 4.0. 

Connecting 3.1 and 4.0 Workstations to the Same Database 

In some cases, it may be necessary to connect both MiPACS 3.1 and MiPACS 4.0 workstations to the 

same database. Examples of such situations include: 

• Legacy hardware is still in use and working with MiPACS 3.1 but not supported by 4.0. 

• A gradual upgrade of a large system where both versions need to co-exist until all workstations 

have been upgraded. 

In order to make this work, both a MiPACS 3.1 and a MiPACS 4.0 license must be stored in the common 
database. Both licenses must be issued to the same customer name. Add the MiPACS 3.1 license from a 

3.1 workstation and the MiPACS 4.0 license from a 4.0 station after you connect it to the database. 
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2.14 Problem Solving/Troubleshooting 

If there are any problems with MiPACS or any attached equipment, please verify that the installation 
instructions in this document and all instructions from the manufacturers of the attached equipment have 

been followed. 

Medicor Imaging manufactures only the image management system and the included software 
components, such as plugins. Problems with third-party hardware or software that are attached to 
MiPACS (such as sensors, cameras, drivers, or patient management systems) are beyond the scope of 

Medicor Imaging. In such cases, contact the distributor or manufacturer of the hardware or software for 

assistance. 

If MiPACS has lost the connection to the network or server, a network error appears until the connection 

is restored. Such errors do not generally indicate a problem within the MiPACS software. 

If a software error occurs in MiPACS, a warning message appears, and the error is logged to a file. Please 

report any software errors to Medicor Imaging as soon as possible. The System Information utility (which 
you can access from the Help menu) displays the configuration of the system. Also, the utility allows the 
error log to be inspected and the report to be transmitted to Medicor Imaging for collection of user 

statistics and troubleshooting. 

If there are any other problems that you cannot solve using the information in this document, contact 

Medicor Imaging for assistance. 

A few common problems and solutions appear in the following table. 

Problem Cause Solution 

Message “No access to 
network or database” appears 
on workstation. 

Network cable is disconnected, 
or database server is 
unavailable. 

Check the network connections of the 
workstation. Check that the SQL 
database server is available to the 
client. 

Message “Image store folder 
not available” appears on 
workstation. 

Server hosting the image store 
folder or network connection is 
down. 

Check that the server that hosts the 
MiPACS image store is available to the 
client. Check that the user has read and 
write access rights to the image store 
folder. 

Message “There is only XX 
MB free disk space…” 
appears on workstation. 

There is too little disk space 
remaining in the image store 
folder. 

Free up disk space, or replace the disk 
with a larger capacity one. 

Database server is non-
responsive or backup system 
is not working. 

The SQL Server transaction log 
file has grown extremely large, 
and the disk is full. The log is 
deleted when a backup is 
performed, so this is a sign that 
backups are not working. 

Perform a backup of the SQL Server 
database. This will empty the log file. 

Toolbars or menus are 
corrupted, or items are 
missing. 

Menus were altered by user, or 
menu file has been damaged. 

Go to Preferences > User, select the 
Reset menu and toolbars checkbox. 
Then, restart the application. 

Message “NOT FOR 
CLINICAL USE” appears. 

The configuration is corrupted, 
or invalid components are 
found. 

Do not use the software! Completely 
uninstall MiPACS, and reinstall it from 
a verified installation package. 
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Problem Cause Solution 

On-screen, an X appears in 
place of an image. Message 
about manipulated or missing 

image appears. 

Image file is not found where 
expected, or file cannot be 
opened. 

Verify that the image store folder is 
available to the user. Right-click the X 
image, and select Image information. 

Note the path. Open the path in a File 

Explorer window, and look for the file. 
If you find it, try to open it in the 
Import images dialog box to see if can 
be opened. Check that it has the correct 
name according to the path noted. If the 
file is missing, restore it from a backup. 

X-ray image quality is 
consistently poor. 

Uncalibrated X-ray image 
capture chain. 

Calibrate the X-ray imaging system. 

Unable to activate capture 
device, typically a sensor. 
Plugin status indicator stays 
red or switches back to red 
when activation is attempted. 

Hardware or driver failure. Restart computer and device control 
box, and check device cables and 
connection. Check hardware. If possible, 
try device on another workstation to 
verify that the device is not broken. 
Reinstall drivers. For a USB device, try 
connecting without any USB hubs, other 

USB devices, and cable extenders. Try 
different USB ports. Make sure power 
saving features are turned off. 

X-ray device is active but 
does not trigger on exposure. 

X-ray exposure time set too 
low, incorrect configuration 
settings, or uncalibrated image 
capture chain. 

Increase exposure time. Verify 
installation of drivers and configuration 
with manufacturers’ instructions and the 
plugin release notes. Calibrate the 
capture system. 

Sensor spontaneously 
captures/imports images 
without exposure. Images are 
white, gray, or black. 

Sensor is defective and may 
need to be replaced. 

Turn off power to the computer and 
device. Try again on a test patient file. 
If possible, try the device on a different 
station. If it still captures images 
spontaneously, replace the device. 
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3. MiPACS Business Continuity 
If the EDR (Dentrix Enterprise) system is down (offline), you can make changes that will allow X-rays to 
be taken during the EDR system outage. And, once the EDR system is back online, you will be able to 

move the X-rays taken during the outage into the EDR system. 

Note: We highly recommend that you call Medicor support for assistance with reconfiguring the 

MiPACS system when the EDR system is down. 

Medicor (MiPACS) Support: 

Phone: (704)-227-2629 

Email: support@medicorimaging.com 

3.1 EDR MIPACS Business Continuity Software Setup 

Open the MiPACS Dental Enterprise Viewer, and make the following setting adjustments: 

• System > Preferences > Integration tab – Clear the PM System is active, disable edit of patient 

info checkbox. 

 

mailto:support@medicorimaging.com
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• System > Preferences > General tab > Additional Preferences: 

• New Patient – Select the Display custom message on new patient window checkbox, and 
then enter a custom message in the corresponding box. 

• Find Patient – Select the Display custom message on find patient window checkbox, and 
then enter a custom message in the corresponding box. 

 

• System > Preferences > General tab – From the ID number mask list, select Custom Mask. 
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• System > Preferences > General tab > Mask Options: 

• Prefix – Type TEMP_ in the box. 

• Display message if patient records with prefix exist in database – Select the Display 
message when new or existing patient record is loaded checkbox, and then enter a custom 

message in the corresponding box. 

 

3.2 EDR MIPACS Business Continuity User Setup 

While the EDR system is down, do the following to capture and review images in MiPACS: 

1. On the Windows Start menu, select MiPACS Dental Enterprise Viewer to open MiPACS in 

standalone mode. 

2. Enter the generic application credentials to log in. 

3. Do one of the following: 

• To open an existing patient’s record, do the following: 

a. On the Patient menu, select Find patient. 

A pop-up message appears, reminding you that this functionality should be used only 

during the outage. 

b. Enter at least three letters to make the search button available, and then click the search 

button. 

c. Capture and review images as needed. 

Note: When the EDR system is back up, the data will be synchronized in the 

background. 
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• To create a new patient’s record, do the following: 

a. On the Patient menu, select New patient. 

A pop-up message appears, reminding you that this functionality should be used only 

during the outage. 

b. Enter the patient’s information. 

Note: A Patient ID with the prefix “TEMP_” is generated automatically and cannot be 

altered. 

c. Capture and review images as needed. 

When the EDR system is back up, do the following: 

1. With a patient selected in the Dentrix Enterprise Chart, click the MiPACS button to open MiPACS. 

2. If any patient records were created during the outage, a pop-up message appears and informs you 
that patient records with temporary IDs exist and should be updated with the correct EDR Dentrix 

Enterprise IDs. Click OK to proceed, and then complete steps 3–5. 

Note: While working in MiPACS, the following options are not available on the Patient menu: 

• New patient – You cannot create a patient record. 

• Find patient – You cannot search for a patient record. 

 

3. In the Patient Updater application, use the patient search to look up patients records with IDs that 

start with TEMP_. A list of all patient records that were created in MiPACS during the Dentrix 

Enterprise downtime appears. 

4. For each of the temporary patient records, create a patient record in the Dentrix Enterprise Family 

File so you can get the patient ID. 

5. In the Patient Updater application, for each of the temporary patient records, replace the patient ID 

in MiPACS with the patient ID from Dentrix Enterprise. 
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Appendix B: Component-Specific Instructions 

B1. Autoimport 

Description 

You can use the Autoimport plugin to automatically import image files from a folder. You can configure 
a single folder and file name pattern for the plugin. All files matching the file pattern that get added to the 

folder will be imported. A local mapped network drive or UNC path is allowed. 

This plugin is useful for importing images from other software or hardware (such as a digital camera or 

card reader) that stores images in a predefined folder. 

Installation 

1. Install MiPACS with the MiPACS and Autoimport plugin options selected. 

2. In MiPACS, on the Tools menu, select Auto Import plugin to configure the import folder and file 

pattern. 

3. When the configuration is tested and works, select the Delete imported files option to prevent the 

same images from being imported more than once. 

User Instruction 

Open a patient in MiPACS. Make sure that the Autoimport plugin is active. Copy an image file to the 
configured import folder. The image will be imported to the selected patient and deleted from the import 

folder (if so configured). The plugin will not import the same file more than once per session. 

Known Issues 

To avoid import attempts on unsupported file types, make sure you specify a file pattern that excludes the 
unwanted files (such as C:\Import\*.jpg). In this example, the Autoimport plugin will import all files in 

C:\Import\ that have a JPG extension and exclude all others (like thumbs.db). 

Tested Configuration 

MiPACS version: 4.0 

OS: Windows 7, 8.1 
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B2. Belmont BelSensor GOLD 

Description 

You can use the Belmont BelSensor GOLD plugin to acquire images from Belmont BelSensor GOLD 
intraoral X-ray sensors. You can connect up to 10 sensors to the same computer at the same time, but tests 
have only been made with one and two sensors. All connected sensors are automatically activated on 

startup. 

Installation 

1. Install MiPACS with the MiPACS and Belmont BelSensor GOLD plugin options selected. 

2. Select a database, and add the license key. 

3. Install the drivers that came with the sensor according to the manufacturer’s instructions. 

4. Connect the sensor, and make sure that the drivers appear properly in Device Manager. A sensor 

usually appears under Universal Serial Bus controllers. 

5. If your sensor came with a correction file, install it: in MiPACS, go to Tools > Belmont BelSensor 

GOLD Plugin > Setup Belmont BelSensor GOLD Plugin; then, click Copy correction files, and 

select the folder that contains the correction files (*.cor or *.cal). 

6. Restart MiPACS, and test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. When the plugin status indicator shows ACTIVE, you can start capturing. 
The default settings make the plugin activate automatically as soon as a patient is selected. Make sure the 

status indicator shows ACTIVE before exposing the sensor. 

Known Issues 

No driver installer is included with the plugin like in the 3.1 version. Use the driver installer provided by 

the sensor manufacturer. 

Tested Configuration 

MiPACS version: 4.0 

OS versions: Windows 7 32 & 64 bit, Windows 8.1 64 bit Sensor models: EV71JU213 & EV71JU215 

Driver version: Philog SA, ver. 1.3.4.0 2010-02-04 
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B3. Camera WIA 

Description 

You can use the Camera WIA plugin to automatically import images from a device supported by WIA 
(Windows Image Acquisition). Many scanners and digital cameras have WIA drivers that allow them to 
be used with this plugin. In particular, many DSLR cameras support WIA so that images can be captured 

and imported directly when a cable is attached between the camera and PC. 

Installation 

1. Install MiPACS with the MiPACS and Camera WIA plugin options selected. 

2. In MiPACS, on the Tools menu, select Camera WIA plugin to configure the plugin. 

3. Install the WIA device and its driver. 

User Instruction 

Open a patient in MiPACS. Connect or activate the WIA scanner/camera to import images from it. The 

plugin automatically detects connected devices and shows a button for it on the toolbar. The images will 
be imported to the selected patient and deleted from the import folder (if the plugin is configured to do 

so). 

Known Issues 

The Show video preview option only works on Windows Vista. 

The File format option Preserve received format as far as possible is not applicable and will have no 

effect in Enterprise editions. 

Tested Configuration 

MiPACS version: 4.0 

OS: Windows 7, 8.1 
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B4. Carestream 

Description 

You can use the Carestream plugin to capture images from Carestream and Kodak dental imaging 
devices. This includes RVG intraoral sensors, CS phosphor plate scanners, panoramic and cephalometric 

devices, and intraoral cameras. 

Installation 

1. Install and configure your Carestream devices and their drivers according to the manufacturer’s 

instructions. You do not have to install the DIS imaging software. 

2. Install MiPACS with the MiPACS and Carestream plugin options selected. 

3. In MiPACS, go to Tools > Carestream plugin > Setup Carestream plugin to configure the 

plugin. The detected Carestream devices are listed. Select the ones that you want to use from the 

application’s toolbar. 

4. Open a patient in MiPACS. Activate the Carestream plugin by clicking the button on the toolbar for 

your device. Then, capture an image to test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. Activate the Carestream plugin by clicking the button on the toolbar for your 
device. A dialog box appears. According to the manufacturer’s instructions, capture images for the 

selected patient. 

Known Issues 

Some devices in the list of devices for the plugin may not have the expected names. For example, the CS 

7600 scanner may appear as Stella. 

Tested Configuration 

MiPACS version: 4.0 

CS Acquisition DLL: 2.1.79.2, 2.1.80.0 

Hardware: CS 7600, RVG 6000, RVG 6100 

OS: Windows 7 32 bit, 8.1 64 bit 
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B5. C-Takt Link 

Description 

You can use the C-Takt Link plugin to export images, series, and image cards to the C-Takt Link 
communications system. The C-Takt Link client application version 1.82 or later must be installed on the 

computer. 

Installation 

1. Install MiPACS with the MiPACS and C-Takt Link plugin options selected. 

2. Install and configure the C-Takt Link client application. 

3. In MiPACS, go to Tools > C-Takt Link Plugin > Setup C-Takt Link Plugin. Configure the 

plugin to suit your preferences. 

4. Open a patient, select either a whole series/image card in the list or some images on a series/image 

card, and then click the C-Takt Link plugin button to test the system. 

User Instruction 

Open a patient in MiPACS, select either a whole series/image card in the list or some images on a 
series/image card. Click the C-Takt Link plugin button to add them to a new case in C-Takt Link. C-

Takt Link opens. Enter your user credentials. Accept the data exported when prompted to do use. Use the 
icon with a plus sign (+) to add the images to an already open case in C-Takt Link. Selecting individual 
images in MiPACS will only export the selected images to C- Takt Link. Selecting a series or image card 

in the list will include all its images and the layout. 

Only approved images are exported. 

Known Issues 

#561 – Using the plugin with C-Takt 2.0, 2.0.1 or 2.0.2 causes double and/or accumulated imports. This 
does not happen in 1.82. C-Takt/Unident has been able to repeat this and will fix it in a future release. In 

the 2.0.3 beta, it works. 

Tested Configuration 

MiPACS version: 4.0 

C-Takt link versions: 2.0.2, 2.0.3 beta 

OS: Windows 8.1 
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B6. Dentalmind Digital X-ray II 

Description 

You can use the Dentalmind Digital X-Ray II plugin to acquire images from Dentalmind Digital X-Ray II 
intraoral X-ray sensors. It is possible to connect up to 10 sensors to the same computer at the same time, 
but tests have only been made with one and two sensors. All connected sensors are automatically 

activated on startup. 

Installation 

1. Install MiPACS with the MiPACS and Dentalmind Digital X-Ray II plugin options selected. 

2. Select a database, and add the license key. 

3. Install the drivers that came with your sensor according to the manufacturer’s instructions. 

4. Connect the sensor, and make sure that the drivers appear properly in Device Manager. A sensor 

usually appears under Universal Serial Bus controllers. 

5. If your sensor came with a correction file, install it: in MiPACS, go to Tools > Dentalmind Digital 

X-Ray II Plugin > Setup Dentalmind Digital X-Ray II Plugin; then, click Copy correction files, 

and select the folder that contains the correction files (*.cor or *.cal). 

6. Restart MiPACS, and test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. When the plugin status indicator shows ACTIVE, you can start capturing. 
The default settings make the plugin activate automatically as soon as a patient is selected. Make sure the 

status indicator shows ACTIVE before exposing the sensor. 

Known Issues 

No driver installer is included with the plugin like in the 3.1 version. Use the driver installer provided by 

the sensor manufacturer. 

The Dentalmind driver installer requires .NET framework 4.x and must be run manually "As 

administrator" on computers with UAC turned on. 

Tested Configuration 

MiPACS version: 4.0 

OS versions: Windows 7 32 & 64 bit, Windows 8.1 64 bit Sensor models: EV71JU213 & EV71JU215 

Driver version: Philog SA, ver. 1.3.4.0 2010-02-04 
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B7. Dürr VistaEasy 

Description 

You can use the VistaEasy plugin to capture images from Dürr devices supported by the VistaEasy 
framework and drivers. This includes VistaScan phosphor plate scanners, VistaRay sensors, and 

VistaCam cameras. 

Installation 

1. Install the VistaEasy drivers (version 5.3 or later). Restart your PC. Configure your Dürr devices 

according to the manufacturer’s instructions. 

2. Install MiPACS with the MiPACS and VistaEasy plugin options selected. 

3. In MiPACS, go to Tools > VistaEasy plugin > Setup VistaEasy plugin to configure the plugin. 

The detected VistaEasy devices and the number of modes per device are listed. Select the ones that 

you want to use from the application’s toolbar. 

4. Open a patient in MiPACS. Activate the VistaEasy plugin by clicking its button on the toolbar, and 

then capture an image to test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. Activate the VistaEasy plugin by clicking its button on the toolbar. A dialog 

box appears. According to the manufacturer’s instructions, capture images for the selected patient. 

Known Issues 

No known issues. 

Tested Configuration 

MiPACS version: 4.0 

Driver version: 5.7.1.13108 

Hardware: VistaScan Mini Plus 

OS: Windows 7 32 bit, 8.1 64 bit 
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B8. Export 

Description 

You can use the Export plugin to export images to predefined folders and file names. Several destinations 
can be configured. It can optionally run an application with the (first ten) files on the command line. You 
can select to export in several file formats. Exports are made with a single click. The plugin will add a 

toolbar button for each configured export destination. 

Variables can be used in the folder and file names. By default a destination is configured pointing to the 

user's desktop. 

Installation 

1. Install MiPACS with the MiPACS and Export plugin options selected. 

2. In MiPACS (while running as administrator if UAC is turned on), go to Tools > Export Plugin > 
Setup Export Plugin. Edit the default destination, or add new export destinations. Use variables as 
needed (see “Setup Notes”). Optionally, select Run this application after export, and then specify 

a path to an application. 

3. Open a patient, select images, and click the Export plugin button to test the system. 

Setup Notes 

You can use the following variables to configure export destinations: 

%USERDESKTOP% The path to the logged-in Windows user’s Desktop folder. 

%USERDOCS% The path to the logged-in Windows user’s Documents folder. 

%TEMP% The path to the current Windows folder for temporary files. 

%ID% The patient ID. 

%FN% The patient’s first name. 

%LN% The patient’s last name. 

%BD% The patient’s birth date. 

%SX% The patient’s gender. 

%IMGID% The image’s database ID. 

%IMGDT% The image’s capture date. 

The applications that are configured to run after export must support file paths on the command line. The 

files will be passed on the command line as in the following example: 

C:\Windows\System32\mspaint.exe "C:\TEMP\file1.jpg" "C:\TEMP\file2.jpg" "C:\TEMP\file3.jpg" 

User Instruction 

Open a patient in MiPACS, select some images on a series/image card or in the image list. Click the 

Export plugin button to export the selected images to files. Only approved images are exported. 
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Known Issues 

No known issues. 

Tested Configuration 

MiPACS version: 4.0 

OS: Windows 7, Windows 8.1 
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B9. ImageLevel NV SA MDX3 

Description 

You can use the ImageLevel NV SA MDX3 plugin to acquire images from ImageLevel NV SA MDX3 
intraoral X-ray sensors. It is possible to connect up to 10 sensors to the same computer at the same time, 
but tests have only been made with one and two sensors. All connected sensors are automatically 

activated on startup. 

Installation 

1. Install MiPACS with the MiPACS and ImageLevel NV SA MDX3 plugin options selected. 

2. Select a database, and add the license key. 

3. Install the drivers that came with your sensor according to the manufacturer’s instructions. 

4. Connect the sensor, and make sure that the drivers appear properly in Device Manager. A sensor 

usually appears under Universal Serial Bus controllers. 

5. If your sensor came with a correction file, install it: in MiPACS, go to Tools > ImageLevel NV SA 

MDX3 Plugin > Setup ImageLevel NV SA MDX3 Plugin; then, click Copy correction files, and 

select the folder that contains the correction files (*.cor or *.cal). 

6. Restart MiPACS, and test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. When the plugin status indicator shows ACTIVE, you can start capturing. 
The default settings make the plugin activate automatically as soon as a patient is selected. Make sure the 

status indicator shows ACTIVE before exposing the sensor. 

Known Issues 

No driver installer is included with the plugin like in the 3.1 version. Use the driver installer provided by 

the sensor manufacturer. 

Tested Configuration 

MiPACS version: 4.0 

OS versions: Windows 7 32 & 64 bit, Windows 8.1 64 bit  

Sensor models: EV71JU213 & EV71JU215 

Driver version: Philog SA, ver. 1.3.4.0 2010-02-04 

  



 

MiPACS 73 

 

IHS EDR Technical Reference Guide 
 

B10. Instrumentarium 

Description 

You can use the Instrumentarium plugin to acquire images from Instrumentarium-branded devices and 
some other PaloDEx group devices using "DICC" drivers. This includes Instrumentarium Snapshot 

sensors, and OP200D and OC200D extraoral devices. 

Installation 

1. Install the PaloDEx IAM drivers (version 4.22 or later). 

2. Install MiPACS with the MiPACS and Instrumentarium plugin options selected. 

3. Restart the computer. 

4. Open MiPACS, and test the system. 

5. Calibrate the system to get optimal image quality (see the installation instructions). 

User Instruction 

Open a patient in MiPACS. Click the plugin button on the toolbar to activate your device. When the 

plugin status indicator shows ACTIVE, you can start capturing. 

Known Issues 

No known issues. 

Tested Configuration 

MiPACS version: 4.0 

Driver versions: IAM 4.22.10099 

Windows versions: Windows 7, Windows 8.1 

Tested devices: Instrumentarium Snapshot 
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B11. Kavo Gendex 

Description 

You can use the KaVo Gendex plugin to acquire images from KaVo and Gendex X-ray devices. This 
includes panoramic devices, KaVo Dig eXam, VisualiX GX-S, eHD, GXS-700 sensors, intraoral 

cameras, and DenOptix scanners. 

Installation 

1. Install the Gendex gxPicture drivers (version 3.5.0 or later). Select one of the Other application... 
options when prompted to do so. If UAC is off, you can install the drivers after running the 

MiPACS installer. With UAC on, however, it is important to run it before. 

2. Install any calibration files for the device if included. 

3. If MiPACS is not installed yet, install MiPACS with the MiPACS and Gendex plugin options 
selected. If MiPACS is already installed, run the MiPACS installer with only the Gendex plugin 

option selected. See the installation instructions for MiPACS. 

4. Restart the computer. 

5. Open MiPACS, and test the system. 

6. Calibrate the system to get optimal image quality (see the installation instructions). 

User Instruction 

Some Gendex devices like the intraoral sensors are "always-on" devices and will allow capture as soon as 
a patient is selected in the host application. Others may require you to click the plugin button to begin 

capturing. 

Known Issues 

The status indicator of the plugin toolbar is not a true indicator of the device state for all devices. Use the 

applicable icons in the notification area of the Windows taskbar as your device status indicators. This is a 

limitation of the SDK construction and not a bug with the plugin. 

KaVo/Gendex recommends users to turn off UAC to avoid issues. We realize that there are cases where 
this is not possible or convenient (such as with Windows 8.1). To work around problems when using 
UAC, gxStart and any GxVideoApp must be turned OFF before starting MiPACS. The Gendex plugin 
tries to help work around the problem by turning off gxStart at start and close. For this reason, the 

installer also removes gxStart and any GxVideoApp from the Startup folder on systems where UAC is on. 

Older devices may not work on newer operating systems. Refer to this guide for more information about 

this: http://www.gendex.com/filebin/pdf/032- 0297_B_Software_Compatability_Guide.pdf. 

Tested Configuration 

MiPACS version: 4.0 

Driver versions: GxPicture 3.5.1, 3.5.3 

Windows versions: Windows 7 32-bit & 64-bit 

http://www.gendex.com/filebin/pdf/032-0297_B_Software_Compatability_Guide.pdf
http://www.gendex.com/filebin/pdf/032-0297_B_Software_Compatability_Guide.pdf
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B12. Manual Import 

Description 

You can use the Manual Import plugin to manually import image files from a folder by browsing the file 

system. The Manual Import plugin is useful for quickly importing files from a folder. 

Installation 

1. Install MiPACS with the MiPACS and Manual Import plugin options selected. 

2. In MiPACS, go to Tools > Manual Import plugin to configure the plugin options. 

Setup Notes 

• Image type sent – Image type passed to the host application. 

• Send any comments found in the file – Extracts any comments found in the image file as 

comments in the host application. 

• Reduce resolution – Configure the plugin to reduce the resolution of the imported images. Do this 
to improve performance for images that do not need to have the high resolution they were originally 

stored in. Images with a resolution below the setting will not be changed. 

• Device – Options to specify a manufacturer and model for images sent. For example, you can use 
this if you always import images captured with the same camera. 

User Instruction 

Open a patient in MiPACS. Click the Manual Import plugin toolbar button. Browse for and select one or 

more image files. The files are imported. 

Known Issues 

The plugin does not support import of non-image files like .docx (Word) files. If you attempt to import a 

non-image file, the plugin has to be restarted to continue working. 

Tested Configuration 

MiPACS version: 4.0 

OS: Windows 7, 8.1 

  



76 MiPACS 

 
 

IHS EDR Technical Reference Guide 
 

B13. Medspace 

Description 

You can use the Medspace plugin to export images to the Medspace communications service. It requires 

that you have an active Medspace account. 

Installation 

1. Install MiPACS with the MiPACS and Medspace plugin options selected. 

2. In MiPACS (while running as administrator if UAC is turned on), go to Tools > Medspace Plugin 

> Setup Medspace Plugin. Provide your Medspace user name and password, and configure the 

plugin to suit your preferences. 

3. Open a patient, select images or a series/image card, and then click the Medspace plugin button on 

the toolbar to test the system. 

User Instruction 

Open a patient in MiPACS. Select either a whole series/image card in the list or some images on a 

series/image card. Click the Medspace plugin button to add them to a case in Medspace. 

Selecting individual images in MiPACS will only export the selected images to Medspace. Selecting a 

series or image card in the list will include all its images. Only approved images are exported. If 
successful, your Internet browser will open with the Medspace case open and the images added to the 

Images tab. 

Known Issues 

#37 – Does not use the new Medspace API. 

Tested Configuration 

MiPACS version: 4.0 

Medspace API version: Medspace Webservices 1.0  

OS: Windows 8.1 
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B14. Morita 

Description 

You can use the Morita plugin to capture images from Morita dental imaging devices. This includes 

panoramic and cephalometric devices. 

Installation 

1. Install and configure the Morita devices and their drivers according to the manufacturer’s 

instructions. You do not have to install any Morita imaging software. 

2. Install MiPACS with the MiPACS and Morita plugin options selected. 

3. In MiPACS, go to Tools > Morita plugin > Setup Morita plugin to configure the plugin. 

4. Open a patient in MiPACS. Notice that the plugin is active. Capture an image to test the system. 

There is no need to manually activate the plugin. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. Notice the Morita plugin status. When a green light appears, the status is 
ACTIVE, and you can start capturing with the device. The captured images will be assigned to the 

selected patient. 

Known Issues 

No known issues. 

Tested Configuration 

MiPACS version: 4.0 

DixelD OCX: 6.4.0.6 

Hardware: Simulated using raw data files only  

OS: Windows 7 32 bit, 8.1 64 bit 
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B15. Planmeca 

Description 

You can use the Planmeca plugin to acquire images from all Planmeca devices supported by the Planmeca 
DIDAPIUI drivers/subsystem. This includes intraoral sensors (Dixi, Dixi2, Dixi3, and ProSensor), and 

panoramic and cephalometric devices. 

Installation 

1. Install MiPACS with the MiPACS and Planmeca plugin options selected. 

2. Install the "DIDAPI" drivers (version 5.1 or later). Make sure the "DIDAPIUI" and "JRE" 

components are selected during the installation of the drivers. 

3. In MiPACS, test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Select a patient. Activate capture by clicking the plugin button on the toolbar. A dialog box appears and 

indicates the status of the device. Capture images. Close the dialog box when you are done capturing. 

Known Issues 

OS compatibility depends on the available drivers. Ethernet interfaces usually work in both 32- and 64-bit 

environments while other devices may be restricted to 32-bit. 

For best workflow, we recommended selecting both the Auto close exposure dialog option and the Hide 

preview during capture option in the plugin setup. 

The plugin status indicator on the toolbar may not always show the right status. Look for the actual status 

in the preview dialog box that appears when you activate the device. 

Tested Configuration 

MiPACS version: 4.0 

Driver versions: DIDAPI 5.1.0 

OS: Windows 7 x64, Windows 8.1 x64  

Hardware: Planmeca Dixi2 Ethernet interface 

IO, Panoramic & Ceph simulators. 
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B16. Schick Intraoral 

Description 

You can use the Schick Intraoral plugin to acquire images from Schick brand sensors. This includes CDR 

2000 wired and wireless, CDR Elite, and Schick 33. 

Installation 

1. Install MiPACS with the MiPACS and Schick Plugin options selected. 

2. Select a database, and add the license key. 

3. Run the driver installer that corresponds to the sensor model and operating system. Refer to the 

instructions provided by Sirona/Schick (see www.schickbysirona.com). 

4. Connect the sensor, and make sure that the drivers appear properly in Device Manager. A sensor 

usually appears under CDR devices. 

5. Start MiPACS. If a calibration file is provided with your sensor, go to Tools > Schick Plugin > 
Setup Schick plugin, click Sensor options, and then select the Calibration tab. Install the 

calibration file for your sensor. 

6. If installed correctly the plugin will activate the sensor automatically. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Open a patient in MiPACS. When the plugin status indicator shows ACTIVE, you can start capturing. 
The default settings make the plugin activate automatically as soon as a patient is selected. Make sure the 

status indicator shows ACTIVE before exposing the sensor. 

Known Issues 

There are no x64 drivers for CDR 2000 sensors when they are used with the older black "remote" boxes. 

Tested Configuration 

MiPACS version: 4.0 

Devices: CDR 2000, Schick 33 

OS: Windows 7 32-bit, Windows 8.1 64-bit 

  

http://www.schickbysirona.com/
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B17. Sirona 

Description 

You can use the Sirona plugin to acquire images from 2D Sirona devices. This includes Orthophos 

panoramic product family devices, and XIOS, XIOS Plus, and XIOS XG Supreme intraoral sensors. 

Installation 

1. Install MiPACS with the MiPACS and Sirona plugin options selected. 

2. Select a database, and add the license key in MiPACS. 

3. Install the Sirona SIDEXIS XG software (version 2.6 or later). 

4. Install the drivers for the device (XIOS or Ortophos). 

5. Install any calibration/correction files included with the device. 

6. In MiPACS, test the system. 

Note: For best performance, follow the instructions for calibrating your entire system. Refer to the 

installation instructions. 

User Instruction 

Select a patient. Activate capture by clicking the plugin button on the toolbar. A dialog box appears and 

indicates the status of the device. Follow the instructions in the dialog box to capture images. Close the 

dialog box when you are done capturing. 

Known Issues 

No known issues. 

Comments 

XIOS XG Supreme sensors can run with the Schick plugin for an alternative, less intrusive workflow. 

Tested Configuration 

MiPACS version: 4.0 

Device: XIOS XG Supreme 

Windows versions: Windows 8.1 64-bit  

SIDEXIS version: XG 2.61 
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B18. Soredex 

Description 

You can use the Soredex plugin to acquire images from Soredex-branded devices and some other 
PaloDEx group devices using "dsd" drivers. This includes the Digora Optime and Instrumentarium 

Express scanners, Soredex ToTo sensor, and Soredex Vidi intraoral camera. 

Installation 

1. Install the PaloDEx IAM drivers (version 4.22 or later). 

2. Install MiPACS with the MiPACS and Soredex plugin options selected. 

3. Restart the computer. 

4. In MiPACS, test the system. 

5. Calibrate the system to get optimal image quality (see the installation instructions). 

User Instruction 

Some Soredex devices, such as Digora Optime scanners, are "always-on" devices and will allow you to 
scan as soon as a patient is selected in the host application. Others may require you to click the plugin 

button to begin capturing. 

Known Issues 

No known issues. 

Tested Configuration 

MiPACS version: 4.0 

Driver versions: IAM 4.22.10099 

Windows versions: Windows 7, Windows 8.1 

Tested devices: Digora Optime, Digora Toto, Soredex Vidi, Instrumentarium Express 
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B19. TWAIN 

Description 

You can use the TWAIN plugin to import images from a device supported by TWAIN (a standard for 
connecting imaging devices to computers). Most standard flatbed scanners and some dental imaging 

devices have TWAIN drivers that allow them to be used with this plugin. 

Installation 

Install any TWAIN supported devices and their drivers. 

Install MiPACS with the MiPACS and TWAIN plugin options selected. 

In MiPACS, go to Tools > TWAIN plugin > Setup TWAIN plugin to configure the plugin. The 

detected TWAIN devices are listed. Select the ones that you want to use on the application’s toolbar. 

User Instruction 

Open a patient in MiPACS. Activate the TWAIN scanner by clicking its button on the toolbar and 

importing images. The images will be imported to the selected patient. 

Known Issues 

If no TWAIN devices are detected, the plugin setup dialog box cannot be opened. Install your TWAIN 

devices and drivers before configuring the plugin. 

Most TWAIN drivers are made for one-by-one scans using a dialog box that appears on screen. This 

usually makes them inconvenient to use for capturing a series of images. Check if your device has a 

dedicated plugin to use for a better workflow instead of having to use the TWAIN interface. 

Tested Configuration 

MiPACS version: 4.0 

OS: Windows 7, 8.1 

  



 

MiPACS 83 

 

IHS EDR Technical Reference Guide 
 

B20. Video 

Description 

You can use the Video plugin to capture still images from a video camera that you connect to your 
computer. This includes many dental intraoral cameras and web cameras. Cameras with DirectShow 

drivers are supported. 

The hand piece buttons on some intraoral cameras are supported. A foot switch connected to game port or 

COM port (or one simulated through USB) is also supported for controlling the capture. 

Installation 

1. Install your camera and its drivers. Install any footswitch and its drivers. 

2. Install MiPACS with the MiPACS and Video plugin options selected. 

3. In MiPACS, go to Tools > Video plugin > Setup Video plugin to configure the plugin. Select a 
compatible model from the list of supported devices. Optionally, configure the method to use with 

the camera buttons or foot switch. 

4. Open a patient, and click the Video plugin button to test the system. 

Setup Notes 

You can access the settings for your camera driver from the setup menu within the live video window. 
This is also where you can select your driver if you have more than one installed. To make changes, make 

sure that you run this program as an administrator if UAC is turned on. 

The following camera models are known to work with this plugin. If the setting for one camera is known 
to support more models, those appear on the same line. Some devices may have OS-compatibility 

requirements that differ from the main application. 

• Cameras using DirectShow drivers: Panasonic EJ-CA02EPA 

• SUNICam USB 

• Schick USBCam 

• Schick USBCam 2 

• Sopro 617 

• Owandy Real Hi-T 

• OwandyCam 

• DEXIS DEXcam 3: Gendex GXC-300 (can also be used with Gendex plugin) 

• Empia 28XX-based using Snapshot feature: USB CCD CAM MD760, AdvanceCAM AIC899/TPC 

• Soredex Digora Vidi 

• Camera using UVC hardware triggering: Imagin ImageMaster, many webcams 

• KaVo DIAGNOCam (follow instructions in dialog box to enable capture button) 
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User Instruction 

Open a patient in MiPACS. Turn on your camera if needed. Activate capture by clicking the Video plugin 
button on the toolbar. A live video window opens. Here you can freeze, release, and capture images using 

the menu of the window, keyboard, camera buttons, or footswitch (if configured). 

Captured images appear on the Captured images bar on the right. When you are done capturing images, 

close the live video window to let the captured images be imported into the host application. 

In most configurations you can use the following keyboard commands in the live video window: 

Space 

Enter 

Esc 

F 

Freeze/Release 

Capture 

Close capture session 

Full screen 

Known Issues 

The implementations of capture buttons on dental intraoral cameras vary greatly. The creativity to come 
up with new methods is still thriving. Therefore, you may find that your camera's implementation of 
capture buttons is not supported. If this is the case, we recommend using a keyboard, menu options, or a 

footswitch. 

Tested Configuration 

MiPACS version: 4.0 

Hardware: Gendex GXC-300, Soredex Digora Vidi, Panasonic EJ-CA02EPA 

OS: Windows 7, 8.1 
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B21. Canon EOS Direct Capture 

Configure Direct Image Capturing with Canon EOS Camera 

You can configure your system for capturing images in MiPACS with a Canon EOS camera. Ideally, you 
should be able to connect your camera connected to your computer with a USB cable and then capture 
images, which will be stored directly in a pre-selected template in MiPACS without touching the 
computer. This is the most convenient way of capturing images, but it does require that a USB cable be 

connected to the computer during capturing. 

There are alternatives to direct capturing: you can capture images without having your camera connected 
to the computer and transfer the images when you connect the camera to the computer or insert a memory 
card into a card reader. This method, however, requires a few additional steps and will not be described in 
this document. There are also Wi-Fi equipped cameras for transferring images wirelessly. This method 

will not be described in this document either. 

Settings In Windows 

Connect your camera to the computer with the USB cable. Cancel any windows that appear 
automatically. You can select the auto-play behavior for this device or select the Take no action option to 

have Windows do nothing when you connect this device. 

Installation of Canon Software 

Install the application Canon EOS Utility on your computer. The installation disc comes with the camera 
and is probably labelled with “Canon EOS Digital Solution Disk” or something similar. You do not need 

to install any other application from the disc (for example, ZoomBrowser). 

Setup Canon Software 

1. Create a folder on your local disk (such as C:\EOSImages). 

2. Go to Start > All Programs > Canon Utilities > EOS Utility. 

3. Click Preferences at the very bottom (the camera does not need to be connected in order to change 

these settings). 

4. On the Basic settings tab, select the Show [Camera settings/Remote shooting] screen option. 

Leave the other options deselected. 

5. On the Destination folder tab, enter the path to the folder you created in step 1. Leave all other 

checkboxes clear. 

6. Click OK. 

7. Close the EOS Utility. 

Configure Autoimport for Mipacs 

1. Run the MiPACS installer to install the Autoimport plugin. 

2. In MiPACS (while running as administrator if UAC is turned on), go to Tools > Autoimport 

plugin > Setup Autoimport plugin. Under Watched folder, enter the path to the folder you 

created in step 1 (such as C:\EOSImages\) and a file pattern (such as *.jpg). 

3. Select the Auto-activate on startup checkbox 
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4. Click OK. 

5. Restart MiPACS, and verify that the Autoimport plugin is active (a green light appears to the right 

of the plugin button). 

Other Settings In Mipacs 

To ensure that the camera images end up in a certain template, activate the auto-template functionality. To 

do this, complete the following steps: 

1. Decide what template you want to use for your camera images (such as PA5), or create a new 

template in MiPACS. 

2. In MiPACS, go to System > Preferences > Capture. 

3. Select Autoimport plugin from the list, select the Use auto selected template on capture 

checkbox, and then select your template from the list. 

Camera Preferences and Testing 

To get the best performance, configure the camera to save pictures as .jpg files at the lowest acceptable 

resolution. 

Switch off the camera, connect the camera to the computer with the USB cable, and turn the camera on. 

You can now capture an image which will directly transfer into the active patient’s folder in MiPACS. 
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B22. SQL Backup Script 

Description 

sqlbackup is a command line tool that creates a backup of a local MiPACS SQL database. Version 2.0 of 

the script has been updated for MiPACS 4.0 and tested on SQL Server 2012 and 2014. 

Important 

This version of the script will attempt to convert the database to the simple recovery model, which is 
appropriate for smaller organizations. This tool might not be useful for larger installations that need to run 

the full recovery model in order to enable point-in-time recovery. 

Please note that the database backup does not include images. In addition to backing up the database, the 

image folders need to be copied separately to the backup destination. 

Parameters 

In order for the tool to work, five parameters need to be specified: 

• The path where the backup file is written. This may be a local folder or a network path but must be 
writable by the SQL server process. If a path is not given, the default is C:\DEbackup. 

• The user name to use for connecting to the SQL server. This could, for instance, be sa. If a user 
name is not entered, connection using Windows authentication will be attempted. 

• The password that corresponds to the specified user name. Leave this blank for Windows 
authentication. 

• The name of the computer that is running the SQL Server and the instance name (if not using the 
default instance) in a SERVER_NAME[\INSTANCE_NAME] format. SQL Server Express 

instances often use SERVER_NAME\SQLEXPRESS. 

• The name of the database to back up. 

Default Settings 

You can customize the script by editing the default values at the beginning of the script. Once this is set 
up, you can run the backup manually by double-clicking the tool. In addition, you can schedule the script 

to run (for example, nightly) with the Windows Task Scheduler. 

Logging 

By default, information about the most recent backup (such as errors) is logged to the file 
sqlbackup_report.txt, which is located at the same path as the backup file. All previous backups are 
logged in the file sqlbackup.log. However, if the script’s logging parameter under the default settings is 

changed to OFF, the information will instead be printed in the command window. 

Tested Configuration 

MiPACS version: 4.0 

Database engines: SQL Server 2012 and 2014 

OS: Windows 7, 8.1 
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B23. Patient Selector 

Description 

You can use Patient Selector for integrating or linking MiPACS to a patient management system (PMS). 
It can be used if there is no way to link using a native solution (using DELink.dll) or command line (using 
command line link). Patient Selector uses “screen scraping” methods to get the patient data from the PMS 
it is linked to. Several configurations can be created to link to different PM systems. There are no presets 

included in the installation. Check with your distributor if there is one needed or made for your PMS. 

Installation 

The files needed for using Patient Selector are installed with the main application installer. You only need 
to add the configuration to match your PMS. You can create configurations yourself or import 
configurations in a file. To enable Patient Selector, you must run the file PatientScanLink.exe, which is 
located in the application folder. It will add a head icon to the notification area of the Windows taskbar. 

Right-click the icon, and then select Setup. In the Setup dialog box, you can select the Run Patient 

Selector on Windows Startup option to make sure Patient Selector runs automatically on subsequent 
computer restarts. You can also add your PMS configurations and choose options for the behavior of the 

link (see “Configure Patient Selector Behavior”). 

User Instruction 

Select a patient in the PMS. Click the head icon in the notification area of the Windows taskbar. MiPACS 

opens with the same patient selected that is selected in the PMS. 

Configure Patient Selector Behavior 

In the Setup dialog (right-click the head icon, and then select Setup), configure any of the following 

options: 

• Check the Systems to Scan for – Select the PMS configurations that you want to be used when 
clicking the head icon. There are also buttons for adding, editing, and deleting items in this list. For 

more info about the creation of PMS links, see “Configure PMS Links.” 

• Prompt for Add or Merge on New Patients – With this option turned on, any patient found but 
not yet present in the MiPACS database causes a dialog box to appear, where you have the option 
to merge it with an existing patient. This is useful in cases where different patient IDs or patient ID 
formats are used. This option is on by default since it is also useful when creating a new 
configuration. When you have a working configuration and a database with consistent patient IDs, 

we recommend that you to turn this option off. 

• Show Warning on Patients with No Unique ID – With this option turned on, a warning message 
appears if a patient is found when linking does not have a patient ID. If your PMS configuration 
includes the patient ID, this could indicate an incomplete record in your PMS. It is also useful for 

configuring and troubleshooting PMS configurations. This option is turned on by default. 

• Run Patient Selector on Windows Startup – You should turn this option on for all stations that 
use Patient Selector. It causes the Patient Selector head icon to be present in the notification area of 

the Windows taskbar each time the computer is started. 
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• Enable Debug Mode – With this option turned on, a message box appears with the detected 
window data from the PMS before MiPACS attempts to open with that data. This option is useful 
for configuring and troubleshooting the PMS configurations. Turn this option off for production 

use. 

• Configure PMS Links: 

• To add a link, do the following: 

a. Click New. 

b. Under PM system name, enter a name for the PMS link configuration. 

The Dialog caption options appear so you can specify the options that are needed to 
identify the PMS main window and extract patient information from the window’s title 

bar. 

c. Under Fixed title, enter a part of the PMS main window title that is fixed (always the 
same). For example, if the PMS window’s title bar has Dentrix Enterprise Chart - 

Brent Crosby, 123456789, you would enter Dentrix Enterprise Chart. You must 
have something entered for the title that is unique enough for the window to be 

distinguished from all other windows that may be open. 

d. Under Title mask, specify the patient information variables to use for the link and the 

string data to enable Patient Selector to find and separate them. Using the previous 
example title, a suitable title mask would be Dentrix Enterprise Chart - %FN %LN, 

%ID. 

You can use the following variables in mask fields: 

%ID The patient ID. 

%FN The patient’s first name. 

%LN The patient’s last name. 

%FN The patient full name. Attempts to separate the name into first and last. 

%BD The patient’s birth date (in a format that Windows recognizes as a date). 

%XX Text to ignore. 

Note: Consider that names could have spaces in them and that the first or last name 
could be blank. Some parts of the fixed text in between the variable text may need to be 

specified (such as spaces). So, if a space separates ID from first name, enter %ID %FN 

in the mask (with a space in between the variables). 

e. Under Main class, you can specify an optional windows class name for the main PMS 

window. This can help to separate the PMS window from other windows if the title bar 

content is not unique enough but the class name is. 

f. If the patient information needed is not on the title bar of your PMS window, you must 
add Controls. Use the Add, Edit and Delete buttons below the list to manage controls. 
When you are adding controls you specify the Fixed text, Class name and Mask in the 
same way as mentioned previously for the main window’s title bar. In addition, there is 
an ID number that can be used to identify the control in a window. At the very least, 

the Fixed text, Class name, or ID number must be entered to identify the control. 
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• To edit a link, select an existing PMS link configuration, and then click Edit. Right-clicking 
the Edit button opens a special analyze window that you can use to find information about 
the PMS window and its controls. Use this information when you are filling in the Class and 

control ID number fields of a PMS configuration. The content and use of this window is for 

advanced users only. 

• To delete a link, select an existing PMS link configuration, and then click Delete. 

Additional Information: 

• The PMS link configurations are stored in the file PMSystems.INI, which is located in the 
application folder (by default, this is C:\Program Files\MiPACS or C:\Program Files 

(x86)\MiPACS). 

• To move a saved configuration to other workstations, copy the PMSystems.INI to the other 
workstations, replacing any existing files. Restart the workstation to make sure that the new 

.ini file is used. 

• Contact Medicor Imaging for support if needed. 
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B24. Command Line Link 

You can use Command Line Link for linking a patient management system (PMS) that is capable of 
sending patient information on a command line to MiPACS. You can configure the Command Line Link 

as needed. 

Setup Instruction 

1. Configure your PMS to launch the file cmdLink.exe, and add relevant patient information on the 
command line. There might be special instructions on how to do this for your PMS. Ask your 

distributor for this if you do not have that information. 

2. Open the Command Line Link setup by double-clicking the file cmdLink.exe in the MiPACS 
application folder (by default, this is C:\Program Files\MiPACS or C:\Program Files 

(x86)\MiPACS). 

3. Create your own custom configuration to work with your PMS by following the instructions in 

“Custom Configuration.” 

4. Test the system by selecting a patient and clicking the link in your PMS. MiPACS should open with 

the same patient that is selected in your PMS. 

Custom Configuration 

Before creating new or editing existing configurations, you should check with Medicor Imaging or the 

PMS manufacturer if there is already a configuration made for your system. 

Command Line Link (cmdLink.exe) looks for .clc files in the MiPACS application folder. Each .clc file 
contains a configuration for linking to a specific PMS. If you double-click the file cmdLink.exe in File 

Explorer, you can select CLC-file/PMS to use. 

If your system is not in the list, you can easily add one by creating a new text file in the MiPACS 

application folder. Name the file after your PMS, and save it with the extension CLC. To edit an existing 

file, click Edit configuration. 

Depending on how your PMS’s command line looks, you specify either a [Prefix] or a [Mask] section in 

the .clc file: 

• If your PMS sends a command line with prefixes (such as /ID=561231-1234 /FN=John /LN=Smith 

/BD=1956-12-31 /Sex=M), you should create a [Prefix] section. 

• If your PMS sends a command line with all fields in a specific order, with a separator, but without 
prefixes (such as -561231-1234;John;Smith;1956-12-31;M), you should create a [Mask] section. 

Note: You cannot have both of these section in the same .clc file. If a Mask is specified, the Prefixes will 

be ignored. 

Sample .clc file with Prefix section (this sample shows the default values used if no configuration is 

selected): 

[Prefix] 

ID=/ID= 

Firstname=/FN= Lastname=/LN= Birthdate=/BD= Sex=/Sex= [Settings] BirthDateMask= Prompt=No 
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Sample .clc file with Mask section: 

[Mask] 

Mask=-<ID>;<Firstname>;<Lastname>;<Birthdate>;<Sex> [Settings] 

BirthDateMask=YYYY-MM-DD Prompt=No 

Parameters 

The file uses an “ini format.” Include the headers ([Prefix] or [Mask] and [Settings]), and make sure that 

you enter the parameter names exactly as given previously. 

Prefixes 

The prefixes on the command line define each field. For example: 

CMDLINK.EXE /ID=561231-1234 /FN=Brent /LN=Brosby/BD=1956-12-31 /Sex=M 

Note: A PMS might use fixed or configurable prefixes when calling the imaging system. By defining the 

prefixes for each field under [Prefix], you can make Command Line Link recognize your PMS. 

Mask 

If you do not use prefixes, each field is defined by its position on the line. For example: 

CMDLINK.EXE 561231-1234;Brent;Crosby;1956-12-31;M 

Notes: 

• ID is always the first field; Firstname, the second and so on. 

• In the Mask= parameter, you specify the fields by surrounding them with angled brackets (< and >). 
For example: 

Mask=<ID>;<Firstname>;<Lastname>;<Birthdate>;<Sex> 

Fields 

Command Line Link can receive the following fields: 

• ID – This is the unique ID for the patient. It must be provided by the PMS. It can contain  

combination of up to 64 numbers and letters. 

• Firstname and Lastname – At the very least, lastname should also be provided by the PMS for 
good functionality. Both fields can contain up to 100 characters. 

Note: The command line length is limited by the operating system. 

• Birthdate – This parameter is optional. If used, you must also set the "BirthDateMask" below the 

[Settings] header so that the date format is understood properly. 

• Sex – This parameter is optional. If used, the values provided by the PMS should be M for male and 
F for female. Only the first letter of the value will be used. 
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Settings 

• BirthDateMask – Controls the way the birth date is understood by the BD parameter. 4-character 
years are recommended. Preferably specify the date in ISO format (YYYY-MM-DD). If no 

BirthDateMask is specified, the regional settings of Windows are used to read the date. 

• Prompt: 

• YES – If the ID provided by the PMS is not found in MiPACS, you will be prompted to 
associate it with an existing patient or add the patient as a new one. This is useful if MiPACS 

has been used for a while before implementing this link. If you choose to associate the patient 

with an existing one, the ID will be changed in MiPACS to match the ID in the PMS. 

• NO – If the ID provided by the PMS is not found in MiPACS, it will always be added as a 

new patient. The default value is NO. 

Note: If "Prompt=Yes" or "Prompt=No" is provided on the command line, it will override the value 

set in the .clc file. 

Activating the Configuration 

Double-click the file cmdlink.exe in File Explorer. Select your configuration file in the list, and then 

click OK. The cmdlink.exe file and the .clc file should be located in the MiPACS application folder. 

Contact Medicor Imaging if you need assistance! 
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Appendix C: Installation Approval Form 
The technician signs this form for each computer to confirm that the installation was performed correctly 

according to the installation instructions. Use additional forms if there are more than 10 computers. 

The responsible dentist signs the form after calibration to verify correct installation and to approve each 

system for diagnostic use. 

 

Practice Name: ________________________________________________ 

Contact Information: __________________________________________________________________ 

 __________________________________________________________________ 

 

Date: _________________ 

 

Technician Name (Print): ____________________________________ 

Dentist Name (Print): ____________________________________ 

 

Room Number or  
Computer Name 

Installation Performed Correctly 
(Signed by Technician) 

Approved for Diagnostic Use 
(Signed by Dentist) 

   

   

   

   

   

   

   

   

   

   

 

Submit this form to Medicor Imaging by email at support@medicorimaging.com. 

mailto:support@medicorimaging.com
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C. Digital Image Application (DEXIS) 

1. Overview of Application 
The DEXIS software is a software program for general dental and maxillofacial diagnostic imaging. It 
controls capture, display, enhancement and saving of X-ray digital images from digital imaging systems. 
It can also handle other types of images acquired by digitizing film with a flatbed scanner, or color images 

from intra-oral and extra-oral dental cameras. 

2. System Requirements 
Please refer to the following web link for System Requirements.https://www.kavo.com/en-us/resource-

center/system-recommendations-imaging-software 

Prior version system requirements can be found at https://www.kavo.com/en-us/imaging- solutions/dexis-

imaging-suite-imaging-software#technical-details 

3. Basic Network Setup 
See User Manual on page 17 for Network Setup. 

The user manual is located in \DEXIS_950b3_International\Engl-US\DManUS.pdf for DEXIS 9 and 

\DEXIS-CD10US_10.1.6.3\Engl-US\DexisEn.PDF for DEXIS 10. 

4. Installation Steps 
See user Dexis User Manual Installation Section 

5. Data Backup Information 
If using DEXIS 9, backup the “data” folder typically located in C:\DEXIS\DATA 

If Using DEXIS 10, backup the data folder typically located in C:\DEXIS Imaging Suite\Data 

Also backup the DEXIS SQL database if not kept in the DEXIS data folder. 

https://www.kavo.com/en-us/resource-center/system-recommendations-imaging-software
https://www.kavo.com/en-us/resource-center/system-recommendations-imaging-software
https://www.kavo.com/en-us/imaging-solutions/dexis-imaging-suite-imaging-software#technical-details
https://www.kavo.com/en-us/imaging-solutions/dexis-imaging-suite-imaging-software#technical-details
https://www.kavo.com/en-us/imaging-solutions/dexis-imaging-suite-imaging-software#technical-details
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6. Antivirus Exclusions 
The following folders should be excluded from AV: 

C:\DEXIS 

C:\Program Files (x86)\DEXIS 

C:\ProgramData\Kavo Kerr 

This screen should appear at the end of each installation of DEXIS to remind the installer of the folders to 

exclude. 

 

7. Support 
Dexis support can be contacted by calling 888-883-3947 Option 7 
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